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Inventory Operations Guide

Introduction
Welcome to CertiflexDimension Inventory!
This Operations Guide is designed to help you get started using the program.
It is organized in a fashion for first time users and details the steps you need
to follow once the system is installed. It can also be used as a reference to
help you with day-to-day processing.
To get the most out of CertiflexDimension Inventory and to guard against
wasted definition time, it is very important that you read this guide and
familiarize yourself with the product before you begin processing.
This guide is used in conjunction with the CertiflexDimension System
Manager Guide. The System Manager Guide details the CertiflexDimension
terminology, functions, general program overviews, general program buttons,
and fields. It also shows you how to:
Configure Users and Define System Security
Configure User Defined Memos
Change the Processing Date
Add Companies
Print Reports
It is extremely important that you read the System Manager Guide before
you begin using the Inventory program.

What You Need To Know First
This version of CertiflexDimension is a Microsoft Windows® application. You
must be familiar with Windows before you can use the Inventory program.
Before you begin working, make sure that you have correctly installed
CertiflexDimension on your computer. To install the program, refer to the
Installation Instructions included in your package.

Start-Up Cycle
You are ready to begin processing after you:
Install CertiflexDimension,
Read the CertiflexDimension System Manager Guide,
Read the Inventory Operations Guide, and
Add Companies to the System
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Please use the following Schedule of Events as a guide to using the
CertiflexDimension Inventory program.

Schedule of Events
Design your inventory stock numbering scheme on paper: Read the
Maintain Lists section to fully understand how CertiflexDimension
numbers inventory items and what numbering scheme is best for your
company’s needs.
Create the company files: Before the system will allow you to do
anything in Inventory for a company, you must first create the company
files. Refer to the CertiflexDimension System Manager Guide to properly
create the company files.
Define the Master Data: A part of creating the company files is to define
the company's Master Data. These instructions are found in the Defining
the Master Data section. You must properly define the Master Data before
you begin adding inventory items.
Define the Inventory Categories and Locations: Before you start adding
individual inventory items, you may wish to define your Inventory
Categories. Inventory Categories allow you to group similar inventory
items as well as define default setup criteria for each group to be used you
add new inventory item. The inventory system supports up to 25
locations. If you wish to use multiple locations, it is recommended that
you define the locations before adding inventory items. There are also
additional identification sections that are available, such as SubCategories, Production ID, etc. The following list are available for each
inventory item and can be maintained in the corresponding area:
o

Categories: Maintain Categories

o

Item Classes: Maintain Sections

o

Sub-Categories: Maintain Sections

o

Status ID’s: Maintain Sections

o

Production ID’s: Maintain Sections

o

Color ID’s: Maintain Sections

o

Class Sizes: Maintain Sections

o

Units of Measure: Maintain Units of Measure

Gather inventory information: This step is very important and is fairly
involved. Please take the time to gather the information suggested in this
step. It will make your inventory item setup faster and easier.
When you first start using the CertiflexDimension Inventory program, it
is a good idea to take a physical inventory for all of the inventory items.
This will ensure that the on-hand quantities you define are current and
correct. Make sure that you have all the information you will need when
defining the items. When you define inventory items, the system will ask
you for the following information for each inventory item:
o

Inventory stock number

o

Inventory item description

o

Additional description for use on reports

o

Unit of measure
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o

Class (class allows you to group or classify inventory items together)

o

Sales code

o

Purchase code

o

Vendor number

o

Alternate vendor number

o

Vendor item number

o

Alternate vendor ID

o

Unit cost

o

Quantity on-hand

o

Bin number

o

Alternate bin number

o

Minimum quantity needed

o

Minimum quantity to order

o

Quantity on backorder

o

Quantity on order

o

Sales price information for each price level

o

Unit price

o

Markup percentage

o

Quantity break

o

Location information

o

Memo field information

o

User key information

o

Alternate items information

o

Category

o

Sub-Category

o

Status ID

o

Production ID

o

Color ID

o

Size Class ID

It is not mandatory to define the information for each of these fields while
you are adding inventory items. However, we recommend that you define as
much information as possible during the addition of the inventory items so
you can obtain the most complete use of the system.
NOTE: If you are using the multiple location feature, some of
the above items, such as quantity on-hand and quantity on
order, are asked for each location.
Add the existing inventory items: You need to add all existing inventory
items to the Inventory files. Use the information you gathered above to
add the individual standard inventory items and serial master items.
Refer to the Maintain Lists section for a detailed explanation of this
procedure.
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Print the Inventory Maintenance Report and Cost Report: These reports
allow you to verify that the information you entered for each inventory
item is correct. Refer to the Standard Inventory Reports section for a
detailed explanation of this procedure.
Make a backup: You have now added all of your inventory information
and you are ready to begin normal processing. It is very important that
you make a backup of the Inventory data files to guard against the
possibility of losing your work.
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Defining the Master Data - Inventory

Company Master Data
Company Master Data settings allow you to configure the Inventory portion
of the program to fit the individual company’s needs. The program
configuration is very flexible. The fields defined in this option are very
important as to how the system will operate. Please read this section so that
you may define the Master Data in the manner best suited for the company.
To open the Master Data, click >File >Company Maintenance and >Master
Data Properties. Click >Inventory.

Main
Select the Main tab to define the following:

.
Name: Enter or change the name of the company. This will be the
company name the system will use when printing reports.
Cost Method: Select the cost method you want to use for the inventory
items.

o

Average Cost: When you record receipts, the system will adjust the
item’s cost to the weighted average cost paid for that item.

o

Latest Cost: The system will change the item’s cost to the latest cost
paid for that item.

o

Standard Cost: You define the cost of the item and the system will
not change that cost no matter what was actually paid for the item.
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Withdrawal Method: Select the withdrawal method you want to use for
the inventory items. You can choose either Cost or Price.
When entering withdrawals from the Inventory program, the system will
automatically call up the cost or price for that item, depending on how
this field is defined.
The normal withdrawal method is Price. If you withdraw items from the
inventory at cost, the system will have no way to calculate gross profit.
Physical Count Method: Select the physical count update method you
want to use for the inventory items.

o

Add to Existing: The system will add the physical quantity you enter
in Updating Physical Counts to the existing physical quantity onhand.

o

Replace Existing: The system will replace the existing quantity onhand with the physical quantity you enter.

o

Prompt Each Time: The system will ask you which update method
you wish to use each time you open Updating Physical Counts.

Price Calculation Method: Select what the system should access for price
calculations when performing global price changes.

o
o

None: The system will deactivate the global price change feature.

o

Based on Price Level 1: The system will perform the global price
change based on the price of Price Level 1.

Based on Cost: The system will perform the global price change
based on the cost of the items.

Access Key: Throughout the program the system prompts you for
inventory items. Here you define the way the inventory items are asked
for (indexed). Select the format you want to use for the main, primary
inventory item index.
User Key: The program also allows you to define a user key. This key is
used to title inventory items with code words that are easier to remember
than their name or number. You can then index the system to locate
items by the user key. On this screen, you define the title for the user key.
J/E Description: Enter the description of the journal entry for processing
a Job Cost withdrawal. If you are operating interactively with the
General Ledger and Job Cost programs the system will use this field to
determine the description of the journal entry for the job cost withdrawal.
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Alert Memos/Price Levels
Select the Alert Memos/Price Levels tab to define the alert memo
descriptions, price level descriptions, and security access levels necessary to
view memos on inventory items.

Alert Memo Descriptions and Access Levels: The program allows you to
maintain up to four lines of information on each inventory item that the
program does not already have a field for. Memos can be used for
reminders, special notes, etc.
This screen allows you to define the headings of the four alert memo
lines.
For each memo line, you can set a security access level so only people
with the appropriate access level can modify and add the alert memos.
Refer to the CertiflexDimension System Manager Guide for detailed
information on access levels.
Price Level Descriptions: The inventory program allows you to specify up
to 10 different price levels for each inventory item. Define the
descriptions of the various price levels at this screen.
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Reporting
Select the Reporting tab to define the number of lines to skip for various
Inventory reports. When you open this program, the system will list a variety
of reports and the number of lines to skip for that report. The number of lines
to skip refers to the number of lines to skip between each item and
transaction included on the selected report.

If you set the number of lines to skip for a report to 0, the system will not skip
any lines between each item and/or each transaction. 1 specifies to skip one
blank line, 2 specifies to skip two blank lines, etc. The system will allow you
to specify a number of lines to skip between 0 and 6.
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G/L Direct Interaction
Select the G/L Direct Interaction tab to define default ledger accounts for
various direct inventory transactions.
Most inventory transactions that update the General Ledger occur in other
modules, such as Accounts Payable, Purchase Order, Order Entry and
Accounts Receivable. The Inventory system does however contain specific
types of transactions that may optionally be set to update the General Ledger
directly.
To enable automatic interactivity between your Inventory and General
Ledger modules, check the G/L Direct Interaction box.

The system will list the following accounts:
Inventory Account (1): Assign the inventory account (1) to be debited on
direct inventory receipts/finished goods productions or credited (cost) on
direct inventory withdrawals/bill of materials (BOM) components. This
account will be used for all inventory items setup with an Inventory
Account number of (1).
Inventory account (2 - 5): optionally assign any alternate accounts to be
debited on direct Inventory Receipts/ finished goods productions or
credited (cost) on direct Inventory withdrawals/ bill of materials (BOM)
components. These accounts will be used for all inventory items setup
with an Inventory Account number of (2 -5).
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Accrual Purchase Account: Assign the account to be credited when doing
direct inventory receipts.
Example: You buy 20 Widgets at a cost of $1.50 each. If your record this
transaction directly within the Inventory by Recording a Receipt, the
following General Ledger Entry will be made:
Account
Inventory (Widgets)
Accrual Purchase Account

Debit
$30.00

Credit
$30.00

Accrual Sales Account: Assign the account to be debited for sales amount
when processing direct inventory withdrawals.
Example: You sell 10 Widgets for $2.00 each and the Widgets have a cost
of $1.50 each. If your record this transaction directly within the
Inventory by Record Withdrawals, the following General Ledger Entry
will be made:
Account
Widget Sales
Accrual Sales Account
Inventory (Widgets)
COGS Account

Debit

Credit
$20.00

$20.00
$15.00
$15.00

COGS Account: Assign the account to be debited for cost amount when
processing direct inventory withdrawals.
Physical Count Adjustments: Assign the account to be debited or credited
for adjustments made when updating on-hand quantities.
NOTE: During the Update Quantities-On-Hand process, the
system will only use the assigned Physical Count Adjustment
account if the Journal Entry G/L box is checked.
Overhead Account: Select the company’s overhead General Ledger
account, if you are operating interactively with both the General Ledger
and Job Cost programs. The system uses this field to allow the automatic
credit of the inventory overhead on the company’s General Ledger.
This allows you to allocate overhead costs to jobs when you record
withdrawals. When you define each job ledger file in the Job Cost
program, you are allowed to define an inventory overhead percentage for
each job. If a percentage was defined for a job accessed through an
inventory withdrawal transaction, the system will credit the overhead
account on the company’s General Ledger based on the percentage
defined for the applicable job and will add the amount debited on the
selected job ledger.
Journal Entry B.O.M. Production: Select this checkbox if you want the
system to automatically record journal entries for bill of materials
production.
Journal Entry Intercompany Transfers: Select this checkbox if you want
the system to automatically record journal entries for intercompany
inventory transfers.
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Inventory Theory - Serial/Lot Tracking

CertiflexDimension Inventory includes the ability to track additional
information on inventory item transactions. This is commonly used to track
specific serial numbers for each item or lot numbers associated with a group
of items. Utilizing serial/lot number features will allow you to easily track
where an individual item or group of items was purchased or produced and to
whom these specific items where sold.

Activating Serial Lot Tracking on an Inventory Item
To activate serial/lot tracking on a specific item, from the Edit Inventory
Item screen, select the Serial/Lot No. Tracking checkbox. You can also set
this option to be the default on a specific Inventory Category. Setting the
default on a category will automatically set all items added to the
category to have Serial/Lot Tracking enabled.

Processing Item Transactions with Serial/Lot Tracking
When a Serial/Lot Tracking enabled item is selected for purchase, production
or sale the system will automatically display the Inventory Serial/Lot
Number window.

Serial/Lot Number: Enter the Serial/Lot Number you wish to track for
this transaction. Tracking numbers are a maximum of 30 alpha/numeric
characters.
Mark As Closed: Select this option if the current Serial/Lot Number
should be considered closed. Each Inventory transaction history line has
a status of open or closed. If you are using true serial number tracking
with only one unique serial number for each item, the unique serial
number would be considered ‘Open’ when you purchase or produce the
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item. The unique number will be considered closed when you sell the
item, because it will never be resold unless returned. Since transaction
reporting supports including open items only, it is easy to gather
information on items currently available in inventory.
NOTE: When you mark an item as closed when sold, the
system will automatically look for any exact matching serial
number and also mark that transaction history line as
‘Closed’. It is important to note that the ‘Mark As Closed’
feature works automatically when processing single serial
numbers only.
Also, note that you can manually adjust the Open/Closed status of any
Serial/Lot Numbered history transactions by using the Edit Serial/Lot
Number History function located under the Options menu of Maintain
Inventory Items.
Selected: Click this option if you are selling a number highlighted from
the Existing Number(s) listing.
NOTE: If you wish to track where you sell specific serialized
items, but not track their purchase or production, simply type
in the serial number at the time of sale. This additional level
of flexibility supports a broader use of how you wish to use the
additional tracking features.
Add to List: If you wish to add to the current Serial/Lot Number,
highlight the additional number from the Existing Number(s) list and
click Add to List.
Click >Ok to use the Serial/Lot Number for the current transaction line.

Additional Notes on Processing Specific Unique Serial Numbers
If you are tracking specific serial numbers, the system will work best if you
enter a separate line for each serial numbered item. For example, if you are
buying and selling lawn tractors and each tractor has a specific serial
number, when you purchase tractors from your supplier enter a specific line
item for each tractor purchased. If you were buying 10 tractors, enter 10 lines
on the purchase order, with each line with a quantity of 1. The same would be
true when you sell the tractors. If a customer was purchasing 3 tractors from
you, enter three detailed lines with each line a quantity of 1. Using quantities
of 1 for serial number tracking allows the best automatic tracking and
reporting of unique serial numbers.
Note: Most transactions (Invoices, Vouchers, etc.) will ask for item
Serial/Lot Numbers immediately when you select an item. However,
with interactive Purchase Order and Order Entry modules you are
asked for the specific Serial/Lot Numbers at the time of recording
receipts or shipments.

Review/Print
You can review all Serial/Lot Numbers used on specific inventory items by
selecting the Serial/Lot No link located under >Review Inventory Item
>Inventory Item Detail.
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You can print reports with Serial/Lot Numbers by selecting to print the
Serial/Lot Number Report or Serial/Lot Number Report located under the
Standard Inventory Reports options.
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Maintain Lists - Inventory

Maintain Inventory Items
This section explains how you perform maintenance functions on the
inventory items. You can add, change, and delete inventory items. You can
also renumber inventory items.

Adding an Inventory Item
To add a new inventory item, click >Maintain Lists >Inventory >Inventory
Items.
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To add a new inventory item, click >New. The system will prompt you for the
following:

New Item Number: Enter the inventory item number for the new item.
The Inventory program applies an extremely flexible inventory stock
numbering system. Because the system allows a total of up to 30
alphanumeric characters for the stock number, you can use almost any
existing inventory stock numbering scheme.
Before you start adding inventory items, we strongly recommend that you
read this section. You may want to change the stock numbering scheme to
take advantage of special features in the system.
Never begin the item number with a space or a period. If you do this, the
system will not index the inventory item correctly. In addition, never use
an asterisk (*) anywhere in the item number.

o

The total maximum length allowed by the system for an inventory
stock number is 30 characters.

o

Each Inventory item consists of an item number and a category. The
category does not necessarily have to be part of the item number.
Categories may be set up within Maintain Categories/Locations under
the Maintain Lists feature of Inventory.

o

Each Inventory report allows you to print for a range of items. This
feature is very useful if you have defined the stock numbering scheme
to take advantage of it.

o

If you are using the Bill of Materials feature of Inventory, you should
note that you must define all finished goods as well as each of the
individual component parts as inventory items. Labor can also be
defined as an inventory item or items, if desired.

o

If you need to track serial numbered items in the system, there is a
special way you must define the inventory item so it can be tracked as
a serial numbered item. Please refer to the Maintain Lists section of
this guide for information on how to indicate an item is a Serial
Master item.

Description: Enter the inventory item’s description. Because the system
allows you to index and access the inventory items by description, do not
enter an item description that matches that of another item.
Category: Enter the category in which you wish to place this item.
Quantity: Enter the quantity for this item.
Cost: Enter the cost for this item.
Click >OK to continue to the item detail screen.
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Inventory Item Detail

Stock Item Number: The item’s stock number, as entered when the item
was created or renumbered. For information on renumbering an existing
item, refer to the Advanced Maintenance Options: Renumber section of
this guide.
Item ID: This field contains an ID that is unique to this inventory item
and is assigned by the program. This ID is used to identify the item
within the data files. This field cannot be changed.
Active Inventory Item: Select this box to make this inventory item
available for recording inventory transactions. If this box is not checked,
the item will not be available from any menu and will not show up on
many inventory reports unless otherwise specified.
Main
Item Description: The item’s description, as entered when the item was
created or last edited. Since the system uses the Stock Item Number for
indexing, the description may be edited here at any time. For
information on renumbering an existing item, refer to the Advanced
Maintenance Options: Renumber section of this guide.
Additional Report Description: If the inventory item has an additional
description that you wish to appear on reports only, enter the description
in this box. This field is a maximum of 30 alphanumeric characters.
User Key: This is a user definable field that you can use as an index field.
For example, if you would like to use code words for the inventory items,
you can define those code words here. When you access the inventory
item listing, you can change the index to User Key. Then, instead of
accessing the inventory items by number or name (description), you can
access the inventory items for matches in this field. The description
heading for the User Key is defined in the Master Data.
Unit of Measure: Select the unit of measure to use for this item. If you
enter a unit of measure that does not exist, the system will prompt you to
add the new unit of measure. If you add a new unit of measure from this
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option, you should also go to Maintain Unit of Measure Conversions to
define additional information needed for the unit of measure.
If you are using the multiple units of measure feature, please give careful
consideration to the unit of measure selected here for each item. The
multiple units of measure feature allows you to sell products in different
or multiple units of measure different from the unit of measure in which
the item was purchased. Therefore, if you are using this feature, you
should normally define the unit of measure for each item to be the unit of
measure by which you purchase the item. Define the unit of measure
under Maintain Unit of Measure Conversions.
You must define a unit of measure conversion table for each purchasing
unit of measure. Each table allows the definition of up to ten alternate
(selling) units of measure, along with conversion factors and markup
percentages, if applicable.
When you have this defined correctly, the system will automatically
convert the quantities and dollars sold back to the item’s original unit of
measure defined here so that the inventory information will remain
correct.
For a complete explanation of the unit of measure conversion feature,
please refer to the Maintain Unit of Measure Conversions section.
If you always buy and sell the individual inventory item in the same unit
of measure, then your selection is easy. Simply select or add a unit of
measure and ignore the unit of conversion feature described above.
Item Class: Class designation allows you to assign inventory items to a
particular group for classification. You can use Class for many different
purposes. You can class inventory items for departments, product lines,
product types, territories, etc. Most reports in the Inventory program will
allow you to specify a range of classes to report.
The system also uses the Class field to distinguish inventory items such
as drop shipment items. These are items that you sell but are not part of
the company’s inventory. That is, you are selling an item to customers,
but the item is being shipped to the customers from another company.
This means you never actually received or shipped the item.
Since it is not an item you stock, you do not want these items to appear in
the regular inventory reports. To separate these items, the system
reserves classes 90-99 for drop shipment items. If you have any items for
drop shipment, assign those items between classes 90 and 99.
You have the option to name the various classes for easier reference. To
rename classes, click >File >Supervisor Options >Maintain Class Names.
Alternately, classes may also be renamed by going to >Maintain Lists
>Inventory >Categories, Locations and Sections: Maintain Sections.
Category: The Inventory program allows you to group similar items in
categories. Specify the category to which this item belongs in this field.
You may define categories in the Maintain Categories option. Please refer
to the section concerning Maintain Categories for more information on
setting up categories.
Sub-Category: You may select a sub-category for more specific grouping
when sorting by category for reporting. Sub-categories are from 1-99. For
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information on defining Sub-Categories, refer to the Categories,
Locations and Sections: Maintain Sections portion of this guide.
Status ID: This optional, user-defined identifier allows you to define your
inventory outside of class and category designations. For information on
defining Status IDs, refer to the Categories, Locations and Sections:
Maintain Sections portion of this guide.
Production ID: This optional identifier can be used to define finished
goods. For information on defining Production IDs, refer to the
Categories, Locations and Sections: Maintain Sections portion of this
guide.
Color ID: This optional identifier can be used to define items by color. For
information on defining Color IDs, refer to the Categories, Locations and
Sections: Maintain Sections portion of this guide.
Item Size Class: Select the item’s size class. For information on defining
Item Size Class, refer to the Categories, Locations and Sections:
Maintain Sections portion of this guide.
Item Size: Enter the item’s size. This field is optional and not required for
processing.
Item Weight: Specify a weight for the item to assist in calculating
shipping charges. You can specify weight in pounds, ounces, kilograms, or
grams.
Total All Locations
Cost: The total overall unit cost for all locations is displayed. This cost is
automatically adjusted as you record purchases to an item.
Quantity: The total quantity On-Hand for all locations is displayed. This
is this quantity that will be updated as you record inventory transactions.
It is this field on which all inventory value calculations are based.
Minimum Quantity Needed: The total quantity needed on-hand for all
locations is displayed.
Quantity On Order: The total quantity on order for all locations from
vendors is displayed. This quantity is automatically updated if you are
operating interactive with the Purchase Order program.
Quantity On Backorder: The total Quantity On Backorder for all locations
committed to customers is displayed. This quantity is automatically
updated if you are operating interactive with the Order Entry program.
Exclude from Lists
Purchases/Sales/B.O.M. Detail: Check the corresponding boxes to exclude
this item from any or all of the aforementioned list types.

o

Exclude from Purchases : Check this option if the current item
should not be available for purchase – i.e. a finished good item that
you manufacture.

o

Exclude from Sales : Check this option if the current item should not
be available for resale or withdrawal – i.e. a raw material that you
use in production only.

o

Exclude from B.O.M Detail : Check this option if the current item
should not be available in Bill of Material detail – i.e. items
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purchased for resale or finished goods not used in other production
components.
Additional
Favorite: You may choose to make data entry faster by setting up
frequently accessed inventory items as Favorites. Favorites are limited to
99 items. Assign the inventory item a number from 1-99 to designate the
item as a Favorite.
To enter an item as a Favorite during data entry, type in the number
specified followed by an asterisk (*). This will select the inventory item
associated with that Favorite number.
Inventory Acct. No.: Select the item’s default ledger account number, as
defined in the Inventory Master Data’s G/L Direct Interaction settings.
Serial/Lot No. Tracking: Check this box if this item is a serial numbered
item. This will let the system know you wish to track serial/lot numbers
for the item. For more information about Serial/Lot No. Tracking, please
refer the Inventory Theory section.

Additional Options
>Location Details: Click on this link to define the inventory item’s location
details.

Each location will be listed with the quantity-on-hand, the cost per location,
and the date of last transaction.
NOTE: Normally, the quantity-on-hand and the unit cost for
an existing item are automatically adjusted as you record
inventory item transactions. You may manually adjust these
fields using the Physical Inventory program. Making direct
changes to on-hand quantities or cost is normally done only
under the direction and supervision of your company
controller.
Other information for each location is as follows:
Last Count Date: This field indicates the last date an item count was
performed for the selected location.
Physical Count: This field shows the actual quantity of the item
according to the last physical count.
Minimum Needed: Enter the minimum item quantity needed on-hand for
the selected location.
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Minimum to Order: Enter the minimum item quantity to order for the
selected location.
Quantity on Order: If you have any quantity currently on order from a
vendor for the selected location, enter it here. This field is automatically
updated if you are operating interactively with the Purchase Order
program.
Quantity on Backorder: If you have any quantity currently on backorder
and committed to customers for the selected location, enter it here. This
field is automatically updated if you are operating interactively with the
Order Entry program.
Bin No. 1: If you maintain bin numbers, enter the item’s bin number for
the selected location number. This is an optional field and a definition is
not required.
Bin No. 2: If you maintain bin numbers, enter the item’s alternate
(secondary) bin location number for the selected location. This is an
optional field and a definition is not required.
Bin No. 3: If you maintain bin numbers, enter the item’s alternate (third)
bin location number for the selected location. This is an optional field and
a definition is not required.
>Sales/Prices: Click on this link to define the item’s unit price information.

Item Sales Prices: To define or change a price level’s sales price
information, select the price level to change and then click Edit.
o

Sales Price: Enter the sales price for this item.

o

Markup Percentage: Enter a markup percentage, if applicable, for
this item. The markup percentage is used when performing global
price changes.

o

You may optionally set a price level’s markup percentage to 999.xxx%
(xxx equals any number) to cause the system to set that price level to
be equal to the item’s unit cost or price level 1, depending on how the
Master Data is defined, when the option to Recalculate Price Levels
is executed.

o

Quantity Break: The quantity price break feature is provided to speed
data entry while processing inventory withdrawals. To utilize the
quantity break feature, you must define the unit prices for the items
so that the price for price level one is the largest price, the one that a
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customer would pay if he ordered the minimum quantity. The price
levels two through ten should be progressively smaller, to reflect
discounts given to customers for quantity buying.
You should also set the quantity for the quantity break for price level
one at zero. Subsequent price levels should be set for progressively
larger quantities to reflect the increased quantities of the item that
the customer must purchase to be eligible for the price breaks.
For example, suppose we had our price levels defined as:
Price
Level

Unit
Price

Quantity
Break

1
2
3
4
5
6
7
8
9
10

$100.00
95.00
90.00
85.00
80.00
75.00
70.00
65.00
60.00
55.00

0.00
50.00
100.00
200.00
300.00
400.00
500.00
600.00
700.00
800.00

In Record Stock Withdrawals, Record Customer Orders in Order
Entry, or Record Invoices in Accounts Receivable, the system will
automatically call up the correct unit price, based on the quantity
entered. The system will allow you to override the system’s selected
price, if necessary.
In the above example, if the quantity withdrawn is 45.00, the system
will automatically call up unit price level one, $100.00. If the quantity
withdrawn is 50.00, the system will then know to allow for the
advantage of a quantity price break. The unit price automatically
accessed by the system in this case is for price level two, $95.00
If you do not provide quantity price breaks to customers, you do not
need to utilize this feature. Simply set all quantity break fields to
zero.

Special Notes about Sales Prices
The Inventory program allows multiple units of measure. This is an
important feature if you buy inventory items in one unit of measures
and sell them in different units of measure. If you always purchase an
inventory item in one unit of measure and sell it in a different, single
unit of measure, then you should define the item so that its unit of
measure is the purchasing unit of measure. The item’s unit cost
should correspond to the unit of measure by which you purchase the
item. The unit prices for the item, however, may be defined in one of
two ways depending on your needs: to correspond to the standard
(purchasing) unit of measure or to correspond to the alternate
(selling) unit of measure.
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If you define the unit prices to correspond to the item’s standard
(purchasing) unit of measure, then you will need to define that unit of
measure’s conversion table so that the conversion factors used are
applicable for the unit cost for the item. The unit of measure
conversion table also allows for the definition of a markup percentage.
The system will use this when processing withdrawals to calculate
the unit price to use that will correspond to the alternate (selling)
unit of measure. The system will use both the conversion factor and
the markup percentage under this method.
If you define the unit prices for the item to correspond to the
alternate (selling) unit of measure, then the system will go directly to
the item’s unit prices when withdrawals are entered. The unit of
measure conversion table will have no markup percentage defined in
this case, and the conversion factor is only used for the update of
quantities sold and the cost of sales. This method is useful when
setting up a markup percentage that will not result in the unit prices
that you want for the item.
The unit of measure conversion table’s Price field must be set
correctly to allow for this feature. The Accounts Receivable and Order
Entry programs also allow this feature, if you are operating
interactively with them. Remember that these two setup methods are
only applicable for items that have a single different selling unit of
measure.
When setting up the Inventory program for the first time, you may
want to take advantage of a special feature allowing global price
changes rather than entering the individual unit prices for each of the
new items.
To use this feature, make sure that the markup percentages for each
item are set the way you want them, then execute the option
Recalculate Prices based on the Markup Percentages. Executing this
option will set the unit prices for each of the price levels for each item
included.
The global price change feature in conjunction with the Calculation
Method definition in Master Data allows you to globally change prices
on the inventory file as a markup of each item’s unit cost, or the unit
price for price level one. If you want to take advantage of this feature,
first make sure you have defined the unit cost or price level one unit
price and the markup percentages for each applicable item.
Check Quantity Available: You may select whether or not you want the
program to check the available quantity of the inventory item either
when recording Customer Orders, Customer Invoices, or both.
Sales Code: The sales code for each inventory item is used when
operating interactively with the CertiflexDimension Accounts Receivable
and Order Entry programs. The Accounts Receivable program uses the
sales code to provide you with sales analysis information. If you are
operating interactively with Accounts Receivable, we recommend that you
read the section of the Accounts Receivable manual devoted to sales codes
before you define this field.
Select a sales code to use for this item from the available drop-down list.
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Default Quantity for Sales: This field will allow you to specify the
quantity in which this item is usually sold. This will save time during the
data entry process because it allows you to bypass the quantity field when
recording an entry.
Invoice/Order Item Description: In this field, you can specify up to a 254character description for this item to print on an invoice or order. This is
a memo format field that allows you to use Smart Tags replacements
within your description. Smart Tags are case sensitive. Using Smart
Tags allows the system to automatically change the Invoice/Order
description if you renumber rename the inventory item. The following
Smart Tags are available for Invoice/Order descriptions:
o

{StockID}: This Smart Tag will automatically be replaced with the
inventory item number.

o

{StockDesc}: This Smart Tag will automatically be replaced with the
inventory item description.

o

{SerialNumber}: This Smart tag will automatically be replaced with
the selected Serial/Lot Number for this transaction line.
NOTE: The above memo description also supports automatic
word-wrap and multiple lines. Remember to use Ctrl + Enter
to input line breaks if you are processing with your User
Preferences set to Use Enter as Tab.

>Purchases: Click this link to assign vendor information to the item,
allowing you to track the vendors from which the item is purchased.

Vendor Numbers & Vendor Stock ID Numbers: You may specify up to
four vendors from which the item is purchased and the stock number the
vendor uses for the item. If you are using a stock number matching the
primary vendor’s number, you can click on the Copy button beside the
vendor stock number to copy the item number from the item and
associate it to the vendor.
Purchase Code: Allows you to specify a default Purchase Code for use
with this item.
Default Quantity to Purchase: If you always purchase a specific quantity
of this item, you can set a default quantity in this field. This will save the
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time required to enter the quantity you are purchasing when generating
a purchase order for this item.
Purchase Order Description: In this field, you can specify up to a 254character description for this item to print on your purchase order. This is
a memo format field that allows you to use Smart Tags replacements
within your description. Smart Tags are case sensitive. Using Smart
Tags allows the system to automatically change the Purchase Order
Description if you renumber and/or rename this inventory item. The
following Smart Tags are available for Purchase Order Description:

o

{StockID}: This Smart Tag will automatically be replaced with the
inventory item number.

o

{StockDesc}: This Smart Tag will automatically be replaced with the
inventory item description.

o

{VendStockID}: This Smart Tag will automatically be replaced with
first vendor stock number for this item. If the first vendor stock
number for the item is not set, this Smart Tag will automatically be
replaced with inventory item number.

>Alerts Memos: Click this link to maintain information that is not already
captured on each inventory item. Memos can be used to track reminders,
special notes, special prices, etc.

The headings for the alert memos are defined in the Master Data and the
headings for all other memo lines are defined in the Configure Memos option.
To open the Configure Memos option, click >File >Supervisor Options
>Maintain Memo names.
NOTE: You must have Supervisor rights (access level 10) to be
able to modify the memo headings in the Configure Memos
option.
Each memo line can be assigned an access level (1-10). If you do not have an
access level equal to or greater than the one assigned to the memo line, you
cannot edit the memo line.
Memo Lines: If you have access to the memo lines, enter the information
in each appropriate field.
Pop-up Alert: You can use any or all four alert memo fields as automatic
reminder fields. If you select the Pop-up Alert check box on any of the
four alert memo lines, all text for the memo lines will display on the
screen anytime this inventory item is accessed.
Refer to the CertiflexDimension System Manager Guide for more information
on configuring memos.
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Editing an Inventory Item
To change an inventory item, click >Maintain Lists >Inventory >Inventory
Items.
When the Maintain Inventory Items screen is displayed, enter the inventory
item to change in the Search field or select the item from the inventory
listing. When a valid inventory item is select, click >Edit and the Edit
Inventory Item screen will be displayed.

For detailed information on each field displayed, refer to the Adding an
Inventory Item section.
NOTE: If you change the unit of measure for an item, be sure
to also change all fields for the item that corresponds to the
unit of measure (quantities, prices, etc.). If you do not, the
system will not function correctly.
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Deleting an Inventory Item
To delete an inventory item, click >Maintain Lists >Inventory >Inventory
Items.
When the Maintain Inventory Items screen is displayed, enter the inventory
item to delete in the Search field or select the item from the inventory listing.
When a valid inventory item is select, click >Delete and a confirmation
window will be displayed.

To confirm deletion of the item, click >Yes. To cancel the item’s deletion and
return to the Maintain Inventory Items screen, click >No.
NOTE: The system will not prevent you from deleting items
from the inventory files, even if the item has an on-hand
quantity. Therefore, you must be careful when you execute
this option. Also be careful not to delete serial master items
that still have corresponding serial numbered items.
If you are using the Bill of Materials feature, the program will
not allow you to delete the inventory item included in the Bill
of Materials. You must remove the item from the Bill of
Materials should you wish to delete it.
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>Alternate Items List
The system will allow you to define alternate items per inventory item. If you
have alternate items defined, when you enter withdrawals for this item and
there is not enough stock on-hand to complete the withdrawal, the system
can display all alternates defined. You can then ask the system to take the
stock from any of the alternate items, if desired.

Click the New button to select an alternate item from the inventory item
listing.
Click the Delete button, to remove the alternate item from the current
inventory item.
Click the Goto Item button to move to the selected alternate item in the
Maintenance system.

>Item Images
CertiflexDimension allows you to attach an image file to the inventory item
and add a description of the item. This image and description will show up in
a Catalog report generated through standard Inventory reports.

Image Link: Type the path name of the file for the image or click Browse
to select the appropriate file. Click >Clear to revert to No Image
Selected.
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NOTE: Screen Item images handle either JPEG or Bitmap
files. The Catalog Report will only print Bitmap files. If you
are utilizing this report with images, you will need to convert
you JPEG files to Bitmaps.
You can click Load Image to Viewer in the Image box to open the Image
Viewer screen.
Image Catalog Description: Enter the description of the image. You can
add up to 254 characters.

>Item Lookup Keys
Each Inventory Item may optionally contain up to 5 individual "Lookup" keys
used to find a specific item during transaction processing. To maintain your
Lookup keys for this item, enter your keys below and click > Save. To use a
Lookup key during transaction processing, type in or scan your lookup key
into the Inventory Item prompt and then press the > F12 Key.
NOTE: Only the "Primary Lookup Key" may optionally be
printed as a Bar Code on Inventory Item Labels.

>Price
Use this option to make direct changes to an Item’s sales prices directly from
the main screen. You may optionally access this option with [Ctrl/P]. Once
you have made all your desired price changes, click > Save.

>Notes/Links/Memos
The Quick Notes and Links tabs allow you to organize and access information
about inventory items from one location. Notes can be used to document
vendor warranty, special order information, labor considerations, etc. Links
can be used to connect to vendor web sites, spreadsheets, and customer
service databases.
You can add and review Quick Notes and Links in Maintain Inventory Items
and Review Inventory Items. For detailed steps on adding Quick Notes and
Links, refer to the CertiflexDimension System Manager Guide.
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Additional Options >AdvancedRecalculating Inventory Item Location
Quantity
Use this option to recalculate a single inventory item’s location quantities.
Overall quantities will be updated for all active locations.
To recalculate an inventory item’s location quantity, click >Maintain Lists
>Inventory >Inventory Items. From the Maintain Inventory Items screen,
select >Additional Options >Advanced and the Advanced Maintenance
Options screen will be displayed.

To recalculate all location quantities for all active locations, select the
inventory item account you wish to recalculate and click >Update Now.
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Renumbering an Inventory Item
To renumber an inventory item, click >Maintain Lists >Inventory >Inventory
Items. From the Maintain Inventory Items screen, select >Additional Options
>Advanced and the Advanced Maintenance Options screen will be
displayed.
NOTE: You should have a current backup of all inventory files
prior to selecting this option. No other users should be
accessing inventory while this process is running.

The system will prompt you to enter the New Number for the inventory item.
Enter the new number and click >Update Now. When a new item number is
entered and saved, the system will renumber the inventory item and all
history transactions associated with that item.

34

Edit Item On-hand Quantities/Cost
This option will allow you to edit either the cost or the quantity on-hand of an
inventory item. To edit item quantities and cost, click >Maintain Lists
>Inventory >Inventory Items.
From the Maintain Inventory Items screen, select >Additional Options
>Advanced and the Advanced Maintenance Options screen will be
displayed. Click >Edit Cost/Qty and the system will display the following:
NOTE: Normally, the quantity on-hand and unit cost for an
existing item are automatically adjusted as you record
inventory item transactions. Making direct changes to onhand quantities or the cost of inventory items should only be
done under the supervision of your company controller.

Inventory Item: Specify the inventory item for which you would like to
update the quantity or cost.
Location: Specify the location of the inventory item you are desiring to
change.
New Item Quantity: Enter the new on-hand quantity for the item you
have selected.
New Item Cost: Enter the new cost for the item you have selected.
Once you have made the necessary changes to quantity and cost click
Accept, then select another inventory item to change.
Items to Post: This will show a list of all items with changes made that
need to be posted to your Inventory files.
Delete: Highlight an item to post and click Delete to remove it from the
list.
Import: If you have several items to update, you can import the
information using this feature. The import file must be an ASCII, tabdelimited file for the import to work properly. The fields in this file are
Item Number, Location, and Quantity or Cost. You can select either
Quantity or Cost to import, but not both at the same time.
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Post All: When you are finished with your modifications, click this button
to post the changes to your Inventory files.
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Edit Serial/Lot Number History
This option allows you to find a specific serial numbered item from a list of
items and mark it either ‘open’ or ‘closed’. This is useful if you desire to resell
a returned serial numbered item. To edit Serial/Lot number history, click
>Maintain Lists >Inventory >Inventory Items.
From the Maintain Inventory Items screen, select >Additional Options
>Advanced and the Advanced Maintenance Options screen will be
displayed. Click >Edit Serial/Lot and the system will display the following:

Serial/Lot History: This will present a listing of all serial/lot numbered
items available, as well as their current status within the system.
Find: This will allow you to search for a specific item from this list.
Mark as Closed: To close a serial/lot number item, highlight the item in
the list and click on this option. This will close out the item.
Mark as Open: To re-open a closed Serial/Lot Number item, highlight the
item in the list and click on this option. This will re-open the item.
Show Open Only: This toggle is used to specify whether or not you desire
only the open items to be displayed.
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Resetting Standard Cost for Items
This option allows you to change the selected inventory item’s standard cost
to the actual average cost. In the Master Data, you defined the cost method to
be Standard, Latest, or Average. No matter which cost method you use, the
system will still track all three.
You will only use this option if the cost method is set to Standard and you
wish to change a group of inventory items’ standard cost to the actual average
cost. The actual average cost is based on the life of the inventory item.
Print the Detailed Cost Report before executing this option. This report will
list each inventory item’s current/standard cost and also show you what its
actual average cost would be.
To reset the standard cost, click >Maintain Lists >Inventory >Inventory
Items.
From the Maintain Inventory Items screen, select >Additional Options
>Advanced and the Advanced Maintenance Options screen will be
displayed. Click >Reset Standard and the system will display the following:

Beginning Item: Enter the item you want the resetting process to begin
with.
Ending Item: Enter the item you want the resetting process to end with.
Other Ranges: You can also specify a range of items by Location, Class,
or Category. This is useful if you desire a more targeted range.
Prompt me on each item whether to accept the new cost: Select this
check box if you want the system to prompt you to accept the new cost on
each item in the above range.
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Global Inventory Recalculation
The global recalculation options allow you to recalculate all inventory location
quantities and/or all inventory detailed history. To perform global
recalculation, click >Maintain Lists >Inventory >Inventory Items.
From the Maintain Inventory Items screen, select >Additional Options
>Advanced and the Advanced Maintenance Options screen will be
displayed. Click >Reset Standard and the system will display the following:

Global Recalculate – All Inventory Location Quantities: Overall
quantities will be updated for all active locations. You should have a
current backup of all inventory files prior to selecting this option and no
other users should be accessing inventory while this process is running.
To perform this process, click >Recalculate Now.
Global Recalculate – All Inventory Detailed History: Use this option to
recalculate ending quantities on-hand used in historical inventory
reporting. Use the Oldest Transaction Date to determine the oldest
transactions to adjust. You should have a current backup of all inventory
files prior to selecting this option and no other users should be accessing
inventory while this process is running. To perform this process, defined
the Oldest Transaction Date and click >Recalculate Now.
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Maintain Categories, Locations and Sections
CertiflexDimension Inventory’s Maintain Categories option allows you to
define up to 999 categories for grouping inventory items together for
reporting purposes.
You can also define up to 25 inventory item locations using the Maintain
Locations option.
New to CertiflexDimension v10 is the Maintain Sections option, allowing you
to define various section used to categorize and identify items.
To access these options, click >Maintain Lists >Inventory >Categories,
Locations and Sections.

Maintain Categories

New: Select this button to add a new category to the list. You will be
prompted for the following information:
o

New Category Number: Enter a number between 1 and 999 for the
new category. Click Ok to accept this category number.

o

New Category Description: Specify a name for the new category.
These prompts are used as defaults the next time you add a new
inventory item with this category. They can be changed at any time.

40

Once you have defined the new category’s number and name, click
>OK to continue to the Maintain Category screen.

Item Class: Specify an Item Class for the new category. Item Classes are
defined under Maintain Class Names in your Supervisor Options.
Invoice Description: In this field, you can specify up to a 254-character
description for the item your wish to print on your invoice or order. This
is a memo format field that allows you to use Smart Tags replacements
within your description. Smart Tags are case sensitive. Using Smart
Tags allows the system to automatically change the Invoice Description if
you renumber or rename the inventory item. The following Smart tags
are available for Invoice Descriptions:
o

{StockID}: This Smart Tag will automatically be replaced with the
inventory item number.

o

{StockDesc}: This Smart Tag will automatically be replaced with the
inventory item description.

o

{SerialNumber}: This Smart Tag will automatically be replaced with
the selected serial/lot number for this transaction line.
NOTE: The above memo description also supports automatic
word-wrap and multiple lines. Remember to use Ctrl + Enter
to input line breaks if your user preferences are set to Use
Enter as Tab.

Inventory Account: Select the inventory account associated with this
category. Inventory Accounts are used only when interactive with
Accounts Receivable, and are specified in the Accounts Receivable sales
codes within System Sales Codes.
Purchase Description: In this field, you can specify a 254-character
description for the item you want to print on your purchase order. This is
a memo format field that allows you to use Smart Tags replacements
within your description. Smart Tags are case sensitive. Using Smart
Tags allows the system to automatically change the Purchase Description
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if you renumber or rename this inventory item. The following Smart
Tags are available for purchase description:
o

{StockID}: This Smart Tag will automatically be replaced with the
inventory item number.

o

{StockDesc}: This Smart Tag will automatically be replaced with the
inventory item description.

o

{VendStockID}: This Smart Tag will automatically be replaced with
first vendor stock number for this item. If the first vendor stock
number for this item is not set, this Smart Tag will automatically be
replaced with the inventory item number.

Sales Code: Specify the sales code which is associated with this category.
This feature is used when you are interactive with the Accounts
Receivable module.
Purchase Code: Specify the purchase code which is associated with this
category. This feature is used when you are interactive with the Purchase
Order module.
Master Item: Select this box if the category specified is to be used as a
master item. This will allow items in this category to be designated as
serial numbered items.
Check Quantity in AR: Select this box if you wish items from this
category to check quantities on-hand when recording Accounts Receivable
transactions. This feature is used when you are interactive with the
Accounts Receivable module.
Check Quantity in OE: Select this box if you wish items from this
category to check quantities on-hand when recording Order Entry
transactions. This feature is used when you are interactive with the
Order Entry module.
Default Category Sales Prices: Here you may define a category’s default
markup percentage, quantity breaks, price levels and corresponding
amounts.
Edit: Highlight a category and click Edit to make changes to the
properties of the category. Once changes are made, click Save to retain
your settings.
Delete: Highlight a category and click Delete to remove the category
from the list. You cannot delete a category having inventory items
assigned to it.
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Maintain Locations

Edit Location Name: Highlight a location and click this button to edit the
name of the location.
Set Default Location: This feature will allow you to specify a default
inventory location. Highlight the location you wish to use as a default
and click this button to make the selected location the default for your
inventory items.
Set Maximum Number of Locations: You may choose to have up to 25
locations for your inventory items. Click on the up and down arrow keys
to increase or decrease the number of locations, then click Save Maximum
Locations to change the maximum number of inventory locations.
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Maintain Sections

Inventory items may be organized based on user-defined terms or Sections,
such as classes, sub-categories or status, production, and color identification.
The Maintain Sections program allows you to customize the numbering and
description of your inventory’s Item Class, Sub-Category, Item Size Class,
Status ID, Production ID, and Color ID.
Item Class: Class designation allows you to assign inventory items to a
particular group for classification. You can use Class for many different
purposes. You can class inventory items for departments, product lines,
product types, territories, etc. Most reports in the Inventory program will
allow you to specify a range of classes to report.
The system also uses the Class field to distinguish inventory items such
as drop shipment items. These are items that you sell but are not part of
the company’s inventory. That is, you are selling an item to customers,
but the item is being shipped to the customers from another company.
This means you never actually received or shipped the item.
Since it is not an item you stock, you do not want these items to appear in
the regular inventory reports. To separate these items, the system
reserves classes 90-99 for drop shipment items. If you have any items for
drop shipment, assign those items between classes 90 and 99.
Sub-Category: Sub-Category designation allows you to assign inventory
items to a particular group for classification and identification based on
criteria that are more specific or altogether different than an existing
grouping category; i.e. - average replace days or periods. Sub-Categories
are available in report filtering and exports.
Item Size Classes: Size Class designation allows you to assign inventory
items to a particular group for classification and identification based on
physical size; i.e. – small, average, large or over-sized. Item Size Classes
are available in report filtering and exports.
Status ID: Status ID designation allows you to assign inventory items to a
particular status group for further classification and identification. Use
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this classification if you need to further expand the Active/Inactive Status
setting available on your items. Status IDs are available in report
filtering and exports.
Production ID: Production ID designation allows you to assign inventory
items to a particular production group. The Production groups may be
changed during “Record Assemblies” and are tracked in Item production
history. Production IDs are also available in report filtering and exports.
Color ID: Color ID designation allows you to assign inventory items to a
particular group for classification and identification - I.e. – Blue, Red,
Etc. Color IDs are available in report filtering and exports.
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Maintain Unit of Measure Conversions
The CertiflexDimension Inventory program allows you to buy and sell
individual inventory items in different units of measure. Multiple units of
measure are allowed for each item in the selling (withdrawal) mode.
NOTE: If you were not taking advantage of the multiple unit
of measure conversion feature, you would use this option to
define the standard units of measure. Simply leave all
alternate unit of measure fields blank.
For example, suppose you have a hardware business. You may purchase nails
from the vendor at 10,000 pieces per case (CS). When you sell the nails to
your customers, you might sell them in boxes of 1,000 (BX1), boxes of 500
(BX2), boxes of 250 (BX3) or boxes of 100 (BX4). Calculating the correct unit
sales price and cost of sales makes the process almost impossible to handle
manually.
Unit of measure conversion tables allow you to define unit of measure
conversions so that the system can perform the processes associated with
multiple units of measure for you. Once the tables are defined, the system
will take care of the conversion for you automatically.
This option allows you to define an unlimited number of conversion tables.
Each table that you define should correspond to one of the standard units of
measure. Within each table, you can define up to ten alternate units of
measure, which correspond to the standard unit of measure for that table. In
our example above, case (CS) would be the standard unit of measure because
the sample company purchased nails from the vendor by the case of 10,000.
Therefore, we would define a unit of measure conversion table for CS. On this
table, we would define boxes of 1,000, 500, 250, and 100 as alternate units of
measure.
Each table allows you to specify whether to multiply or divide the standard
unit of measure by the alternate. For each alternate, you can define the
conversion factor and markup percentage, if applicable.
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Adding a Unit of Measure Conversion Table
To add a new unit of measure conversion table, click >Maintain Lists
>Inventory >Unit of Measure Conversions.

To add a new unit of measure conversion table, click >New. The system will
prompt you for the following:
Unit of Measure: Enter the standard unit of measure to use for this table.
The system allows a maximum input of three alphanumeric characters.
Using our example above, we would enter CS here.

Click >OK to continue to the Edit U/M Conversions screen.

47

At the Edit U/M Conversions screen, you may define the following:

Description: Enter a description for this conversion table. Continuing
with our example, our description would be “Case.”
Operation: Select Multiply if you want the system to multiply the
conversion factor for each alternate unit of measure on this table by the
quantity withdrawn, unit price, and unit cost for the original unit of
measure. Select Divide if the original quantity withdrawn, unit price, and
unit cost should be divided by the conversion factor for each of the
alternate units of measure in this table.
Using our example above, we would set this field to Divide.
Access: Select Automatic if you want the system to always automatically
call up the data defined for the first alternate unit of measure. You are
never given an option to override this choice of alternate units of measure
during stock withdrawals. This method is useful if you always buy the
inventory items in one unit of measure and always sell them in another
unit of measure. This choice allows automatic processing in the
withdrawal mode without requesting input from you.
Select Display Options if you want the system to always display all the
alternate units of measure defined here when recording stock
withdrawals. This method is useful if you have more than one standard
unit of measure when selling the inventory items.
Using our boxes of nails example above, we would set this field to Display
Options.
Price: This field specifies to the system whether the unit prices for items
that will access this conversion table will correspond to the original unit
of measure or the selected alternate unit of measure.
If you are defining more than one alternate unit of measure for this
conversion table, you should always set this field to Original U/M.
If you define only one alternate unit of measure for this conversion table,
you can define this field to Alternate U/M. You should only use this option
for an original (standard) unit of measure that is defined for items where
the unit prices for the items correspond to the alternate unit of measure.
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Using our boxes of nails example above, we would set this field to Original
U/M.
Alternate: Enter the alternate unit of measures to use for this conversion
table. Using our boxes of nails example above, we would enter BX1, BX2,
BX3, and BX4.
Conversion Factor: Enter each alternate unit of measure’s conversion
factor. Be sure that the conversion factor you enter corresponds to the
combination of the original (standard unit of measure), the operation
(multiply or divide), and the alternate unit of measure.
Using our boxes of nails example above, BX1 has a conversion factor of 10
(BX1 is a box of 1,000 nails, which is 1/10th of the case of 10,000 nails,
and since our operation is dividing, BX1 will divide CS by 10. BX2 has a
conversion factor of 20, BX3 is 40, and BX4 is 100.
NOTE: Regardless of the price level basis chosen for the
conversion table, if you enter an actual dollar amount for the
unit withdrawal price during stock withdrawals (as opposed
to entering a price level number 1-10), the system will ignore
the conversion factor defined here and will use the unit price
entered at its face value.
Markup %: If you want the system to calculate the unit price based on the
conversion factor and then to markup that unit price by a certain
percentage, enter that percentage amount here.
NOTE: If the price level basis is defined to Alternate U/M or if
you enter a dollar amount for the unit withdrawal price
during stock withdrawals, the system will ignore any markup
percentage defined.

Changing a Unit of Measure Conversion Table
To change a unit of measure conversion table, click >Maintain Lists
>Inventory >Unit of Measure Conversions.
When the Maintain Unit of Measure Conversions screen is displayed, enter
the unit of measure to change in the Search field, or simply click and
highlight the desired conversion table, and then click >Edit. The system will
display the information for the selected conversion table. For detailed
information on each field displayed, refer to the Adding a Unit of Measure
Conversion Table section.

Deleting a Unit of Measure Conversion Table
To delete a unit of measure conversion table, click >Maintain Lists >Inventory
>Unit of Measure Conversions.
When the Maintain Unit of Measure Conversions screen is displayed, enter
the unit of measure to delete in the Search field, or simply click and highlight
the desired unit, and then click >Delete. A window will appear, confirming
that you wish to delete the selected conversion table. Click >Yes.
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Maintain Price Levels
This section allows you to make global price changes to the inventory files.
You can change price levels by price amounts only, by using a fixed amount,
by a percentage, or by completely recalculating the amount. Or, you can
change price levels by markup percentages and prices or by markup
percentages only.

Maintaining Price Levels
To maintain price levels, click >Maintain Lists >Inventory >Price Levels.

Type
Select the type of global price level change you wish to perform
Prices Only: This option allows you to change the price amounts for any
range of price levels desired and any range of stock items desired. If you
choose this type, select the method to use under Change Method:

o

By a Fixed Amount: This method allows you to globally increase or
decrease the price amounts based on a fixed dollar amount.

o

By a Percentage: This method allows you to globally increase or
decrease the price amounts based on an input percentage.

o

By Recalculating: This method allows the system to automatically
recalculate and reset unit prices.
For the system to properly perform the recalculation, several Master
Data settings are used. First, the system will look at the definition of
the Price Calculation Method field. In this field you specify that the
system should use either each item’s unit cost or price level one as a
base for recalculation. Next, the system looks at the markup
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percentages for each of the price levels on each inventory item that it
will recalculate. Depending on whether the price calculation method
is set to cost or price, the system will increase or decrease the unit
prices for each of the inventory items and price levels specified.
Two examples will help explain this:
Example #1
Item Stock Number: 5650-10050-95000
Item Description: 8’ Landscape Timber
Automatic Price Calculation Method: Cost
Unit Cost: $3.50
Price Levels: 1-3
Price and Markup Percentages prior to recalculation look like this:
Price
Level
1
2
3

Markup
Percentage
50.00%
65.00%
70.00%

Unit
Price
$0.00
0.00
0.00

Price and Markup Percentages after recalculation:
Price
Level
1

Markup
Percentage
50.00%

Unit
Price
$5.25

2

65.00%

5.78

3

70.00%

5.95

As you can see from this example, the system set the unit price for
each of the price levels as a percentage increased based on the item’s
unit cost. The recalculation does not affect the markup percentages.
This example also illustrates a manner in which you can save
considerable definition time for prices when you first begin using the
program. If the prices for the items are based on percentage increases
of the unit costs, then you may define the markup percentages for
each of the price levels in the initial item addition mode. Then, using
this recalculation method of global price change, allow the system to
automatically calculate and set the unit prices for each of the price
levels.
Example #2
Item Stock Number: 5650-10050-95000
Item Description: 8’ Landscape Timber
Automatic Price Calculation Method: Price
Price and Markup Percentages prior to recalculation look like this:
Price
Level
1

Markup
Percentage
0.00%

Unit
Price
$5.50
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2

15.00%

0.00

3

25.00%

0.00

Price and Markup Percentages after recalculation:
Price
Level
1
2
3

Markup
Percentage
0.00%
15.00%
25.00%

Unit
Price
$5.50
6.33
6.88

In this example, the system set the unit prices for price level two and
three as a percentage increase based on the unit price for price level
one. As in the previous example, recalculation does not affect the
markup percentages.
This example also illustrates a possible way in which you can save time
during inventory item setup. Define the markup percentages for each of
the price levels for the items, and also make sure to define the actual unit
price for price level one. Then, using this recalculation method of global
price change, allow the system to automatically calculate and set the unit
prices for the remaining price levels.
If one of the markup percentage fields for an item is set to 999.xxx%, the
system will set the unit price for that price level equal to either the item’s
unit cost or the price for price level one, depending on how the Master
Data is defined, when you recalculate.
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Markup Percentages and Prices: This option allows you to increase or
decrease the markup percentages and automatically change the
applicable unit prices to reflect the new markup percentages.
An example should help explain this:
Item Stock Number: 5650-10050-95000
Item Description: 8’ Landscape Timber
Amount of Change to the Markup: 5.00%
Price Levels: 1-3
Price and Markup Percentages prior to markup look like this:
Price
Level
1
2
3

Markup
Percentage
50.00%
65.00%
70.00%

Unit
Price
$5.25
5.78
5.95

Price and Markup Percentages after markup:
Price
Level
1
2
3

Markup
Percentage
55.00%
70.00%
75.00%

Unit
Price
$5.51
6.06
6.25

As you can see from this example, each of the markup percentages are
increased by 5.00% and each of the unit prices are also increased by
5.00%.
If one of the markup percentage fields for an item is set to 999.xxx%, the
system will set the unit price for price level one, depending on how the
Master Data is defined, when you markup.
Markup Percentages Only: This option allows you to increase or decrease
markup percentages only. This option does not change the unit prices.
The Master Data field Price Level Descriptions allows you to define the
descriptions for each of the price levels, level 1-10. You define the markup
percentages for each of the price levels in the default inventory item.
During the addition of inventory items, if all of the items use the same
markup percentages as defined in the default inventory item, then the
initial setup is easy. None of the markup percentages need to be changed.
However, if you have a situation where certain groups of items on the
inventory file have specific markup percentages that are not the same as
the default inventory item, then you can use this option to globally
change the markup percentages for these groups of items. Using this
option will allow you to change entire groups of items at one time, saving
you from having to change each item individually.
Remember that this option does not change unit prices. After executing
this option to change markup percentages, you should execute the option
above to recalculate the unit prices for all affected price level/inventory
item combinations.
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Export Prices to ASCII: This option allows you export sales prices to an
ASCII file. The system will export the following information to a file
labeled: \CertiFlx\ADVX\XConnect\INVPRICE.TXT

o
o
o

Column A: Inventory Item Number
Column B: Price Level (01-10)
Column C: Sales price

Import Prices from ASCII: This option allows you to import price
information from an ASCII file. The ASCII file should contain the stock
number, price level, and sales price information and should follow the
exact same format that the system uses when exporting prices to ASCII.
If you are not aware of that format, choose the option to export, edit the
ASCII file, created, and update the file for the new prices.

Inventory Item Range Selection
Beginning Item: Enter the inventory item to begin the change with.
Ending Item: Enter the inventory item to end the change with.
Beginning Price Level: Enter the price level to begin the change with.
If you chose to export a price level to an ASCII file, the system will
prompt you for the price level to export.
Ending Price Level: Enter the price level to end the change with.
NOTE: This option is not available if you are importing prices
from an ASCII file.
Amount of Change to the Price/Markup: Enter the amount or the
percentage by which you want the prices for each inventory item in the
above range and for each price level in the above range to change. For an
increase, enter the amount or percentage as a positive number. For a
decrease, enter the number with a - (minus) sign before the number.
Click >Ok to begin the process.
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Customer/Item Price Matrix
If you are using CertiflexDimension Inventory interactive with the
CertiflexDimension Accounts Receivable module, you may optionally setup an
external Customer/Inventory Item Price Matrix.
This system will allow you to override all the standard price levels and
quantity breaks used in determining normal pricing and allow you to set a
specific price for a customer/Inventory Item combination. This is also
commonly referred to as "Customer Contract Pricing.”

The system will use an externally maintained spreadsheet file saved as a tab
delimited text file. The file needs to be located in the XConnect folder of
CertiflexDimension and be called CustItem.Txt
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Bill of Materials - Maintaining Assembled Items
This option allows you to define each of the component items and the
quantities needed for each sub-assembly, assembly, or finished good.

Adding an Assembled Item
To add an assembly to the Bill of Materials, click >Maintain Lists >Inventory
>B.O.M. - Assembled Items.

To add a new assembly, click New Assembly. The system will display an
inventory item listing and prompt you for the following:
Select New Finished Good Item: Select the inventory item that you want
to add the components to. In the example given above, this would be an
inventory item for the Post Hole Digger, Arrow Garden Shovel, etc.
NOTE: The inventory item you select here is not the raw
material item. It is the inventory item you produce that is
composed of the different individual raw materials.
Reference Number: Enter a reference number for this assembly. This
number can be used for tracking or management purposes and will be
displayed on the history reports.
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Add
Click >Add to add the individual components to this assembly.

The system will prompt you for the following:
Inventory item: Select the component to add to this assembly. In our
bicycle example above, if we were defining the Back Wheel Assembly, we
would select the inventory items of Tire, Wheel Rim, Spokes, and the
Brake Sub-Assembly. If we were defining the actual bicycle assembly, we
would enter the inventory items of Back Wheel Assembly, Front Wheel
Assembly, Handlebar Assembly and Chassis Assembly.
NOTE: The system will not allow you to assign a serial
numbered item as a component. If the assembly includes a
serial numbered item, add the serial master as a component.
When you record assemblies, the system will recognize the
serial master and prompt you to enter the serial numbered
item for that assembly.
Step: The system allows you to use this field to define what step in the
production process of the assembly that this component is used. The
system will default with the first step as 10 and will automatically
increment each step by 10 as each component is added. The system
increments by 10 to allow room for future growth of the assembly.
In the future, if a component item is added to this assembly, you will have
plenty of room to add the new component in its proper place so your
components will stay in the order that you desire.
If you allow the system to automatically increment the step numbers or if
you change the step numbers but still maintain incrementing, the Bill of
Materials report will print in step number order. If each component has
the same step number, the Bill of Materials report will print in inventory
item stock number order.
Quantity: Enter the quantity needed for this component to produce one
assembly. In our bicycle example above, if we were defining the
Handlebar Assembly, one assembly would require a quantity of one
basket and a quantity of two streamers. If the component is a serial
master item, the system will automatically assume a quantity of 1.
Location: If you are operating with multiple locations, the system will
prompt you to select the location that this component should be taken
from when the assembly is produced.
When you click >Ok, the system will save that component to the
assembly. Click Add again and add each additional component needed for
this assembly.

Edit
To change a component of an assembly, select the component and click >Edit.
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Delete
To delete a component of an assembly, select the component and click
>Delete.

Copy
Click >Copy to copy another finished good into this assembly. In our bicycle
example above, if we were defining the Chassis Assembly, we would need to
add the Chassis Frame and Decals and then import the Seat Sub-Assembly.
If we were defining the finished bicycle, we would not add any inventory
items. All components will be other assemblies. You use Copy to add those
assemblies to this assembly.
Once all desired items have been added to create the finished good, click
>Save to save the assembled item.
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Reviewing an Assembled Item’s Production Detail
To review an assembly, click >Maintain Lists >Inventory >B.O.M. Assembled Items.
When the Bill of Materials - Maintain Assembled Items screen is displayed,
enter the assembly to change in the Finished Good field and click >Start, or
simply double-click on the desired Finished Good. The system will display
the information for the selected assembly in the lower half of the screen.
Above this detailed listing of an assembly’s items, the system will display the
quantity and date the assembly was Last Assembled On and the assembly’s
current Status.
To review an assembly’s production detail, click on the spyglass icon
the Production Detail screen will be displayed.

and

Production List - This listing allows you to review the selected assembled
item’s transaction details, including Date, Reference Number, Quantity
Produced, Cost, Location, User, Control Number, Production ID, and
Production Notes.
Materials Used List - This listing allows you to review a complete
breakdown of materials used, including each material’s Item Number,
Item Description, Quantity/Finished Good Unit, Cost/Finished Good
Unit, Item Cost, Quantity Used, Extended Cost, Location, and, if
applicable, Serial/Lot Number.
NOTE: Both the Production List and Materials Used List may
be copied to your Windows clipboard by right-clicking on the
listing and selecting Copy Data Listing. This is helpful if you
wish to paste either listing into a third-party spreadsheet
format.
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Changing Assembled Items
To change an assembly, click >Maintain Lists >Inventory >B.O.M. Assembled Items.
When the Bill of Materials - Maintain Assembled Items screen is displayed,
enter the assembly to change in the Finished Good field and click >Start, or
simply double-click on the desired Finished Good. The system will display
the information for the selected assembly in the lower half of the screen. For
detailed information on each field displayed, refer to the Adding an
Assembled Item section.

Deleting Assembled Items
To delete an assembly, click >Maintain Lists >Inventory >B.O.M. - Assembled
Items.
When the Bill of Materials - Maintain Assembled Items screen is displayed,
enter the assembly to delete in the Finished Good field and click >Start, or
simply double-click on the desired Finished Good. The system will display
the information for the selected assembly in the lower half of the screen.
Click >Delete Assembly.
The system does not verify that the assembly you choose to delete is not a
component of another assembly. Therefore, use caution when deleting
assemblies.
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Maintaining Inventory Sales Kits
Inventory Sales Kits allow you to group multiple inventory items commonly
sold or grouped together for a sale or promotion. This helps make entering
transactions more efficient because you enter all items together.
To maintain an Inventory Sales Kit, click >Maintain Lists >Inventory
>Inventory Sales Kits.
To add a new Inventory Sales Kit, click >New Kit. You will be prompted to
enter a new kit number from 1-999. Once you have selected the kit number,
click >Ok.

Kit Description: Enter a description you wish to use for your inventory
kit.
Reference Number: Enter a reference number for your Inventory Kit.
To begin adding items to your kit, click >Add. The system will then prompt
you for the following:

Inventory Item: Enter the inventory item you wish to add to the kit. You
may type in the inventory item number, or press [F6] and select the item
from the inventory listing.
Line: You may specify the order the items will appear in your transaction
detail by selecting a line number to associate with the item.
Quantity: Enter the quantity of the item to be included in the kit.
Location: Specify the location of the inventory item in the kit.
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Once the information has been entered for the inventory item, click >Ok
to save the line for the kit.
Make any changes to any item in the kit by highlighting the item and
clicking >Edit. To remove an item from a kit, highlight the item and click
>Delete.

Changing an Existing Inventory Kit
To make changes Inventory Sales Kit, click >Maintain Lists >Inventory
>Inventory Sales Kits.
In the Kit Number field, type in the number of the kit or select the kit from
the pull-down menu. Then click >Start to access the kit detail. Make any
changes to the kit and click >Save to retain your changes.

Deleting an Existing Inventory Kit
To delete an Inventory Sales Kit, click >Maintain Lists >Inventory >Inventory
Sales Kits.
In the Kit Number field, type the number of the kit or select the kit from the
pull-down menu. Then click >Start to access the kit detail. Click the >Delete
Kit button to delete the Inventory Kit from the system.
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Physical Inventory
The CertiflexDimension Physical Inventory program allows you to quickly,
correctly, and easily take a physical inventory and update the inventory files
to match the actual physical inventory counts.
Before we describe each option of this feature, please read the following
sections that describe the complete inventory cycle. This will help you use the
physical count features.

Using Physical Counts to assist you with a Physical Inventory
The CertiflexDimension Inventory program tracks the quantities on-hand for
each inventory item. Physical Counts allows you to enter and update the
physical quantities on-hand. The quantity on-hand for each inventory item is
the book quantity on-hand. This is the quantity that is tracked by the system.
The quantity on-hand is automatically updated by the system when you
record inventory transactions. The physical quantity on-hand for each
inventory item is the quantity that you actually, physically counted for the
item in the warehouse or stock shelves.
When you first begin using the CertiflexDimension Inventory program, we
recommend that you take a physical inventory so that you can begin using
the system with on-hand and physical quantities that agree. Hopefully, the
next time you take a physical inventory, the physical quantities will still
agree to the on-hand quantities that the inventory program is tracking.
However, you will find that this is often not the case.
Incorrect on-hand quantities are always the result of input errors or missed
transactions during processing. Incorrect physical quantities are the result of
incorrect counting or misplacement of stock due to theft, shrinkage, etc.
The Inventory program makes it very easy to reconcile differences between
the on-hand and physical quantities. You are encouraged to take a physical
inventory on a regular schedule. The system allows you to utilize this feature
on any schedule desired, or to never utilize this feature at all. However, the
best inventory control and management methods include periodic
reconciliation of on-hand and physical quantities.
When you process a physical count, the unit of measure defined for each item
is the item’s original unit of measure (the unit of measure that the item is
purchased in). When performing the physical inventory, be sure to correctly
count the inventory for the original unit of measure and not for an alternate
unit of measure.
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General Cycle for Performing a Physical Inventory
The system allows you to perform the options of a physical count for any
range of inventory items desired. If you are operating the system with
multiple locations, you can also perform physical inventories for an individual
location, for specified locations, or for all locations. Because the system allows
so much flexibility, you need to be very careful to make sure that the criteria
and ranges of inventory items in each phase of the physical inventory process
are the same. This will ensure that the end results are correct.
When performing a physical count, you should follow these steps:
Backup: Make a backup of the inventory files prior to beginning the
physical inventory process.
Print Count Sheets: Each count sheet provides a place to note up to three
physical counts for each item. Refer to the Inventory Reports section for
instructions on this step.
Perform counts: Perform the actual physical counting of each inventory
item you are performing a physical count for. Record the counts on the
count sheets.
Zero Physical Quantities: Zero out the existing physical quantities in the
inventory files. This will cause each item’s physical quantity to be zero.
This is an optional step and is described below.
Update: Update the physical counts per the physical inventory count
sheets. This step is described below.
Print the Book-to-Physical Report: This report will show the on-hand and
physical quantities for each of the items included. The difference in these
quantity fields will print, as well as the dollar value of the difference.
Refer to the Inventory Reports section for instructions on this step.
Review: Review the Book-to-Physical Report to determine which items
contain a difference that is too large to ignore.
Investigate: Investigate the difference and perform a physical recount for
all differences too large to ignore.
Re-enter: Re-enter the physical quantities for all items recounted.
Repeat: Repeat the above steps until you are comfortable that the
physical quantities entered are accurate.
Print a final report: Print a final Book-to-Physical Report and retain for
your records. This report will contain the dollar value of all differences
resulting from shrinkage, overage, theft, or processing errors. You should
make a journal entry to the General Ledger for this dollar value so that
the General Ledger and the Inventory will remain in agreement.
Update Quantities On-hand: Update the quantities so that the on-hand
quantities match the physical quantities. This step is described below.
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Zeroing Physical Quantities
This option allows you to set the physical quantity on-hand to zero for each
item included in the physical count. This feature is very helpful if you have
many items that you do not regularly keep on-hand. By using this feature,
you can avoid having to individually set the physical quantities on-hand to
zero for those items that you no longer have in stock but want to remain on
the inventory files. You should execute this option before you enter the
physical counts.
To zero physical quantities, click >Maintain Lists >Inventory >Physical
Inventory.

From the Physical Inventory Count Options, select Zero Physical Quantities
and click >Access Now.

Beginning Item: Select the inventory item to begin the zero physical
quantities process with.
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Ending Item: Select the inventory item to end the zero physical quantities
process with.
Other Ranges: You can select additional settings here to specify the
range of inventory items for the zero physical quantities process. You can
select Locations, Classes, or Categories or any combination of these
selections.
Click >Save to begin the process.

66

Updating Physical Counts
This option allows you to enter the latest physical counts for each inventory
item you select. Data entry in this option is very flexible and is designed to be
as fast and easy as possible.
The system allows you to specify how you want to enter physical counts in
this operation. You have two choices:
Add: If you use the add method of entering physical counts, the system
will add the physical quantity that you enter through this option to the
existing physical quantity on-hand for each inventory item included.
Replace: If you use the replace method of entering physical counts, the
system will replace the existing physical quantity on-hand for each
inventory item included with the new physical quantity you enter
through this option.
You can define the system so that it will always operate with either the
replace or the add method, or you can specify that you want the system to ask
you which method to use each time you select this option. This definition is
maintained in the Master Data field Physical Count Method.
To update physical counts, click >Maintain Lists >Inventory >Physical
Inventory.

From the Physical Inventory Count Options, select Update Physical Counts
and click >Access Now.
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Location: The system will display all locations available for this company.
Click on the location(s) you wish to perform the update physical counts
for. The system will place a check mark next to each location selected.
Class Range: Select the range of item classes for which you wish to
update physical counts. If you wish to have the system include drop
shipment items, be sure to include classes 90-99.
Categories: Select the range of categories for which you wish to update
physical counts.
Use Count Date: This option is only available if the Count Method is set
to Replace. If you select this check box, the system will prompt you for
the date the actual physical counts were performed on. Then, when you
enter the physical counts, the system will calculate the transactions
performed for the inventory item between the date the counts were taken
and the date you update physical counts. The system will then adjust the
physical counts for those transactions. This option is used when it takes
more than one day to perform the physical counts and update the
physical counts.
Count Method: If the Master Data field Physical Count Method is set to
Prompt, the system will allow you to select which method to use, Add or
Replace. Otherwise, the selection is already defined for you.
Import ASCII: If you defined the physical counts to a pre-defined ASCII
file, you can import those counts instead of manually entering them. The
file to import must conform to pre-defined specifications. You can review
an example of these specifications in a text file named IN-PHY.DOC. This
file is located in the \CertiFLX\ADVX\XConnect directory.
When this screen is defined correctly, click >Proceed to Step 2 to continue.
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Item: Select the inventory item to update the physical counts for.
Bin Number: If desired, enter the bin number the counts were taken
from.
Add to Physical/Total New Count: If the count method is set to Add, the
system will prompt you for the number of items to add/subtract to/from
the current counts. If the count method is set to Replace, the system will
prompt you for the new count for this item.
On this screen, the system will also display the On-Hand Quantity, the
Physical Quantity, and the Total New Quantity after you enter the counts for
the selected item.
Click >Save to update the counts. When the entered count is saved, the
system is ready for you to enter the next item’s count. If you use the arrow
keys to access the next inventory item, the system will move to the same
inventory item for each location. If you are operating with a single location or
if you access the last location, the system will then scroll to the next
inventory item.
After you enter all physical counts, you should print the Book-to-Physical
Report. If you discover counting or input errors, you should re-input counts
for the incorrect inventory items again. You will only need to re-input counts
for the inventory items that show an error. You do not need to re-input counts
for all inventory items. The system maintains the physical counts until you
re-input a new count or you execute the Zero Physical Quantities option.
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Updating Quantities On-hand
This option allows you to update the quantities on-hand for the inventory
items to match the physical quantities you entered from the last physical
inventory. The system allows you to specify a range of inventory items to
include. Be careful to only include the inventory items that you updated the
physical quantities for.
To update quantities on-hand, click >Maintain Lists >Inventory >Physical
Inventory.

From the Physical Inventory Count Options, select Update Quantities-OnHand and click >Access Now.

Beginning Item: Select the inventory item to begin the update quantities
on-hand process with.
Ending Item: Select the inventory item to end the update quantities onhand process with.
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Other Ranges: You can specify additional settings here for the range of
inventory items for the zero physical quantities process. You may select
Locations, Classes, or Categories or any combination of these selections.
Journal Entry G/L: Select this checkbox if you want the system to make
journal entries that correspond with the update to quantities-on-hand.
Click >Save to continue to the Preparing to Update review screen.

Preparing to Update Quantities On-hand

The Preparing to Update screen allows you to review the item’s to be
adjusted, those items’ locations, on-hand and physical quantities, the
quantity to be adjusted, and unit and extended costs.
NOTE: This listing can be copied to your Windows clipboard
by right-clicking on any item and selecting Copy Data Listing.
This is helpful if you wish to paste the listing into a thirdparty spreadsheet format.
After reviewing this screen and confirming that the adjustments to quantities
on-hand are correct, click >Update Now to complete the process.
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Reviews - Inventory

Review Inventory Items
Reviewing inventory items allows you the ability to look up and review
information about an item without accessing the item through the Maintain
Lists screens. When you need to verify information for an item, you would
use the Review options instead of the Maintain Lists options. Maintain Lists
locks the item, not allowing other users access to the item while you are in
Maintain Lists. When reviewing an item, other users will still have access to
the item for transaction entry.

Reviewing an Inventory Item
To review an item, click >Reviews >Review Inventory Items.

When the Review Inventory Items screen is displayed, enter the item to
review in the Search field, or simply scroll through the inventory item listing.
When a valid item is entered, the system will display the information for the
selected item.
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Search: Enter a character string for the item record you are searching for. The
character search string you enter depends on how you have the Sort By list option
defined.
List Options –

Sort By: Select the column you wish to sort your item listing by.

List Options –
Locate: To refine your item record search, you can locate matches by
using the standard CertiflexDimension Locate dialog. For more information on this
feature, please refer to the section labeled “Using the CertiflexDimension Locate Dialog.”
List Options –
Filter: Using the standard CertiflexDimension Filter dialog, you can
filter any listing so that only matching records appear (i.e. Show only vendors that
contain the word “Acme” in their account name). For more information on this feature,
please refer to the section labeled “Using the CertiflexDimension Filter Dialog.”
Active Accounts Only: Select this option to include only active items in the account list.
All Accounts: Select this option to include all items in the account list.
Views: This dropdown menu provides an assortment of item overviews. Each View
screen will have a Search field located in the upper left corner and an Options button
located in the upper right corner that allows you to apply the standard Sort By, Locate,
Filter, and Details (Drill Down) functions to the current data.
Item Listing: An item listing including overall cost and quantities.
Item Activity: An item listing that displays includes YTD sales amounts and quantities.
Comparative Year Sales: An item listing that displays comparative year sales.
YTD Quantity Analysis: An item listing that displays beginning year quantities to ending
inventory.
NOTE: Since “Alternate Account Views” contain report totals,
these options are only available to user having security access
to both the “Review” and “Report” options per accounting
system.
Quick Print Label
: Allows you to print a user defined context label for the current
account to a specific label printer. For more detail information on configuring and/or
changing Quick Labels for Vendors, Customer, Items and Orders, please refer to your
CertiflexDimension System Manager Guide – Quick Print Labels.
Create New MyNote : Select this option to record and attach a MyNote that will be
associated with the selected account. All of your MyNotes can be accessed from the
main CertiflexDimension System Manager window. For more information on
maintaining your MyNotes system, please refer to the MyNotes overview in your
CertiflexDimension System Manager Guide.
Alert Memo: If the selected item contains alert memos, you can select this option to
review the memos.
Show Item Image : Select this option to direct load the selected item’s image.
Views: This dropdown menu provides an assortment of Inventory overviews. Each View
screen will have a Search field located in the upper left corner and an Options button
located in the upper right corner that allows you to apply the standard Sort By, Locate,
Filter, and Details (Drill Down) functions to the current data.


Item Listing



Item Activity



Comparative Year Sales
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YTD Quantity Analysis



Lookup Key Listing
NOTE: Since “Alternate Account Views” contain report totals,
these options are only available to user having security access
to both the “Review” and “Report” options per accounting
system.

To review an item’s detailed information, double-click on the desired item and
the Inventory Item Detail screen will be displayed.

For detailed information for each field displayed, refer to the Adding an
Inventory Item section.
NOTE: Do not forget to review the Memos, Quick Notes, and
Links for any additional information recorded for the
inventory item. Refer to the CertiflexDimension System
Manager Guide for a detailed explanation on adding Memos,
Quick Notes, and Links.
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Additional Options: History Detail
The Inventory Item Detail screen will also display Additional Options not
found in the Maintain Inventory Items program, such as the selected item’s
transaction history
To access the item’s transaction history detail from the Inventory Item Detail
screen, click >History Detail under Additional Options.

Here you may filter the selected item’s history by Transaction Type, such as
sales, receipts, bill of materials, other transactions, or view all history items
at once. You may also set the Transaction Date Range to display All
transactions, or limit results to either This Year or Last Year’s transactions.
When a particular transaction is selected, that transaction’s detail will be
displayed in fields on the right. This detail includes the transaction’s type,
date, reference, quantity, unit cost and price, location, source account and
agent (if applicable), User ID, Sub-Type, Production ID, History ID, Tracking
ID, Line Number, and Description/Serial Lot (if applicable).
NOTE: Additional transaction details can be displayed by
double-clicking on a listed transaction. However, this feature
is restricted to transactions processed in CertiflexDimension
v10.
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Additional Options: Period Totals
To access the selected item’s period totals from the Inventory Item Detail
screen, click >Period Totals under Additional Options.

This option allows you to display the totals for this item per period and give
you a total for the year. You can view by all locations or an individual
location. You can select the Prior Year checkbox to view the totals for the
prior year.
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Additional Options: Period Graphs
To access the selected item’s period totals from the Inventory Item Detail
screen, click >Period Graphs under Additional Options.

This bar graph allows you to review the selected item’s sales by period,
displaying sales percentage and total sales amount per the end of each
period.
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Review Bill of Materials
The Review Bill of Materials (B.O.M.) screen allows you to look up
information about B.O.M. without accessing it through the Maintain Lists
program, which locks open files associated with the B.O.M. and its
corresponding items, prohibiting other users from accessing these items.
When you use the Review Bill of Materials program, other users will be able
to access B.O.M. information and their corresponding items for transaction
entry and routine processing.

Reviewing Bill of Materials
To review a Bill of Materials, click >Reviews >Review Bill of Materials.

To select a finished good and review its bill of materials, either enter its
number into the Finished Good field or simply click on a finished good in the
listing. Once a valid finished good is selected, its Reference number, date,
last quantity, month-to-date and year-to-date quantities produced, and list of
components and their descriptions will appear on the right.
To access a finished good’s production detail, click on Review Detail. For
more information on the fields displayed in the Production Detail screen,
please refer to the Bill of Materials - Maintaining Assembled Items:
Reviewing an Assembled Item’s Production Detail section of this guide.
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Transactions - Inventory

Record Inventory Entries
Record Inventory Entries allows you to record and post various stock
movements in and out of the inventory. You can enter receipts, withdrawals,
stock transfers (within the same company or between companies), and
purchase orders from this option.
NOTE: If you are using the Bill of Materials feature, the
processing of an item's assembly and disassembly is recorded
using the B.O.M. - Record Assemblies program.
If you are using the Job Cost program, the Job Cost
Operations Guide will detail additional information on
recording and posting inventory transactions. We recommend
that you review that portion of the Job Cost Operations Guide
before you enter transactions.
If you are operating interactively with other CertiflexDimension programs,
you may only occasionally use the transaction options of this program. You
will likely be executing transactions from other CertiflexDimension
programs. For example, you can record inventory receipts through the
CertiflexDimension Purchase Order and Accounts Payable programs. You can
record inventory withdrawals/shipments through the CertiflexDimension
Order Entry and Accounts Receivable programs. The CertiflexDimension
Purchase Order program also allows you to input inventory purchase orders.
Regardless of the method of inventory you use for updating, you should not
repeat the transaction in any other CertiflexDimension program unless you
are not operating those programs interactively with the CertiflexDimension
Inventory program.
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Recording Stock Receipts
This option allows you to update the inventory files to reflect the receipt of
inventory items. When you record stock receipts, the system will update the
following fields:
On-Hand Quantity (normally increased to reflect the receipt)
Quantity on Order (normally reduced to reflect the receipt)
Unit Cost (re-averaged if average unit cost method is used, replaced if
latest unit cost method is used, or no change if standard unit cost method
is used)
Date of last transaction
Units purchased and dollars expended
Inventory history file
NOTE: If you are operating interactively with the
CertiflexDimension Purchase Order and Accounts Payable
programs, you will normally record receipts of inventory items
through one of those programs. DO NOT repeat the
transaction through this option. If you do, you will have
duplicate entries.
To record stock receipts, click >Transactions >Inventory >Record Inventory
Entries.

This screen is divided into two sections. You enter the stock receipt
information in the top section. The bottom section displays the line item
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detail for each type of transaction entered and allows you to edit or delete a
previously entered line item before you post the transactions.
Transaction Type: Select Stock Receipt.
Inventory Item: Select the inventory item for this stock receipt.
Location: Select the location to record this stock receipt for.
Date: Enter the date of this transaction.
Reference: This is an optional field and is not required by the system to
save the receipt. You can use this field to enter any type of reference
number or description. A more detailed Transaction Note may be added
by clicking on the notepad icon .
Quantity Received: Enter the quantity to receive. The system will not
allow you to enter a quantity of zero or to skip this prompt.
Unit Cost/Total Cost: The system will normally prompt you for the unit
cost of the item to receive and will default to the item’s current unit cost.
You can accept this cost or enter the updated cost.
If you are receiving a quantity of more than one and you only have a total
cost of the items (not an individual unit cost), you can cause the system to
prompt you for the total cost instead of the unit cost. When you enter the
total cost, the system will calculate the individual unit cost for you. To
turn on the Total Cost prompt, right-click the Unit Cost box and then
click Enter Cost as Unit Cost (The check mark will disappear.).
Vendor Number: Optionally, you may assign a vendor to the stock receipt
either by entering the vendor number, clicking on the spyglass icon
and selecting the vendor from your vendor listing, or entering the vendor
name or number as needed.
NOTE: For user convenience, the Record Inventory Entries
program refers to your vendor listing to help you locate and
select vendors. However, this does not tie the stock receipt to
your Vendor’s history or any Accounts Payable reports.
Accept: Click >Accept or press [F2] to save the receipt entered.
Cancel: Click >Cancel if the stock receipt is entered incorrectly and you
wish to start over.
The system is now ready for you to enter the next receipt or transaction type.
The system will allow you to enter an unlimited number of stock receipts or
other transaction types before you post the transactions.
When you click >Accept, the system will update the bottom section of the
screen, displaying the total receipts for all receipts entered (as well as the
totals for the other transaction types).
If you have entered other types of inventory transactions within the same
session (withdrawals, transfers, etc.) and wish to return to the stock receipt
type, simply set the Transaction Type at the top of the screen to 1 - Stock
Receipts and the system will display each stock receipt line item entered
during this session.
To change a line item, select the desired line item and click >Edit or double
click on the line. To remove a line item, select the desired line item and click
>Delete.

81

When all stock receipts (and other transaction types) are entered and you are
ready to update the inventory files, click >Post Transactions. The system will
post all transactions and then prompt you to print the transaction listing
reports.

Additional Notes about Recording Stock Receipts
It is important to remember that the receipts, the quantities and unit costs
entered must correspond to the item’s standard unit of measure as it is
defined on the inventory item’s record. The system supports multiple units of
measure and automatic unit of measure conversions for withdrawals (sales)
only.
If you detect a data entry error after you post a receipt, enter a new stock
receipt for the item and enter a negative quantity amount and use the same
unit cost you originally entered. This will restore the updated fields to their
original status before the incorrect receipt was entered.
Please note that there is one exception. If you are using the latest cost
inventory valuation method, the unit cost before the error cannot be
reinstated automatically on the file just by reversing the erroneous receipt
transaction. This is because the system has no way to remember what it was.
In this case, you need to determine the old (correct) unit cost and manually
change the unit cost on the inventory item’s record under Changing an
Inventory Item before entering other transactions involving the item.
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Recording Stock Withdrawals
This option allows you to update the inventory files to reflect the withdrawal
of inventory items. When you record stock withdrawals, the system will
update the following fields:
On-hand Quantity (normally decreased to reflect the withdrawal)
Cost of sales (current and year-to-date dollar amounts)
Unit sales and dollars received
Date of last transaction
Inventory history file
NOTE: If you are operating interactively with the CertiflexDimension
Order Entry and Accounts Receivable programs, you will normally
record withdrawals of inventory items through one of those programs.
DO NOT repeat the transaction through this option. If you do, you
will have duplicate entries.
To record stock withdrawals, click >Transactions >Inventory >Record
Inventory Entries.

This screen is divided into two sections. You enter the stock withdrawal
information in the top section. The bottom section displays the line item
detail for each type of transaction entered and allows you to edit or delete a
previously entered line item before you post the transactions.
Transaction Type: Select Stock Withdrawal.
Inventory Item: Select the inventory item for this stock withdrawal.
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Unit of Measure: The system will prompt you for the unit of measure only
under certain circumstances. The CertiflexDimension Inventory program
supports multiple units of measure and this option allows automatic unit
of measure conversions. The system skips this prompt if any of the
following are true:
o

If you always buy and sell the inventory items in the same unit of
measure.

o

If the selected item’s unit of measure does not match the original unit
of measure for any of the unit of measure conversion tables.

o

If the alternate unit of measure access field for the corresponding unit
of measure conversion table is set to automatic. The system will
always use the first alternate unit of measure from this table.

o

If the unit of measure for the selected item matches the unit of
measure for one of the unit of measure conversion tables, the system
will perform a unit of measure conversion for the current withdrawal.
The manner in which the alternate unit of measure access field is
defined for the unit of measure conversion table will determine how
the system performs the conversion. There are two definition choices
for the alternate unit of measure access field.


Automatic: The first alternate unit of measure defined on the
conversion table is used for this withdrawal and the system will
skip to the next prompt.



Display all options: All alternate units of measure defined for this
conversion table are displayed. You can select one of the
alternates for the current withdrawal.

For more information on the unit of measure conversion feature, refer to
the Maintain Unit of Measure Conversions section.
Location: Select the location to record this stock withdrawal for.
Date: Enter the date of this transaction.
Reference: This is an optional field and is not required by the system to
save the withdrawal. You can use this field to enter any type of reference
number or description. A more detailed Transaction Note may be added
by clicking on the notepad icon .
Quantity Withdrawn: Enter the quantity to withdraw. The system will not
allow you to enter a quantity of zero.
The system keeps track of whether or not the unit of measure is
converted for the current withdrawal. Be sure to enter a withdrawal
quantity that corresponds to the converted unit of measure.
For example, let’s say you purchase an item in pounds (the standard unit
of measure is LBS) and you sell the item in ounces (selected alternate
unit of measure is OZ). A unit of measure conversion table is defined for
LBS with OZ as one of the alternates. The conversion operation for this
conversion table is to divide with the conversion factor at 16. In this
example, if you entered a quantity withdrawn of 32, the system knows
this is 32 ounces and not 32 pounds. This is because the unit of measure
for this item was converted. When the withdrawal is validated, the onhand quantity for the item is reduced by 2, to correspond to the item’s
standard unit of measure (32 ounces divide by the conversion factor of
16).

84

When you enter a withdrawal quantity, the system checks the quantity
on-hand against the withdrawal quantity. If the withdrawal will result in
a quantity on-hand of less than zero, a warning message will display.
Unit Price: If the company’s Master Data Withdrawal Method is set to
Cost, the system will use the item’s unit cost to determine the withdrawal
value. If the Withdrawal Method is set to Price, the system will display
the price based on the quantity of items entered (quantity break price). To
view all prices available, press F4.
Customer Number: Optionally, you may assign a customer to the stock
withdrawal either by entering the customer number, clicking on the
spyglass icon
and selecting the customer from your customer listing, or
entering the customer name or number as needed.
NOTE: For user convenience, the Record Inventory Entries
program refers to your customer listing to help you locate and
select customers. However, this does not tie the stock
withdrawal to your customer’s history or any Accounts
Receivable reports.
Accept: Click >Accept or press [F2] to save the receipt entered.
Cancel: Click >Cancel if the stock withdrawal is entered incorrectly and
you wish to start over.
The system is now ready for you to enter the next withdrawal or transaction
type. The system will allow you to enter an unlimited number of stock
withdrawals or other transaction types before you post the transactions.
When you click >Accept, the system will update the bottom section of the
screen, displaying the total withdrawals for all withdrawals entered (as well
as the totals for the other transaction types).
If you have entered other types of inventory transactions within the same
session (receipts, transfers, etc.) and wish to return to the stock withdrawal
type, simply set the Transaction Type at the top of the screen to 2 - Stock
Withdrawals and the system will display each line item entered during this
session.
To change a line item, select the desired line item and click >Edit. To remove
a line item, select the desired line item and click >Delete.
When all stock withdrawals (and other transaction types) are entered and
you are ready to update the inventory files, click >Post Transactions. The
system will post all transactions and then prompt you to print the transaction
listing report.

Additional Notes about Recording Stock Withdrawals
If the G/L Interactive feature is enabled in the Inventory Master Data and an
Accrual Sales Account has been defined, the system will debit the defined
sales amount when processing direct inventory withdrawals.
If you detect a data entry error after you post a withdrawal, enter a new stock
withdrawal for the item and enter a negative quantity amount. This will
restore the updated fields to their original status before the incorrect
withdrawal was entered.
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Recording Stock Transfers
When there is no purchase or sale involved, this option allows you to record
the transfer of inventory items from one company’s inventory files to another
company’s inventory files. Or, if you are using multiple locations you can
transfer from one location to another location within the same company.
When you record stock transfers, the system will update the following fields:
Quantity on-hand (decreased in the source file or location and increased
in the destination file or location)
Current period and year-to-date unit purchases and purchase dollar
amounts (decreased in the source file or location and increased in the
destination file or location)
Unit cost (updated in the destination file only)
Date of last transaction
Inventory history file
To record stock transfers, click >Transactions >Inventory >Record Inventory
Entries.

This screen is divided into two sections. You enter the stock transfer
information in the top section. The bottom section displays the line item
detail for each type of transaction entered and allows you to edit or delete a
previously entered line item before you post the transactions.
Transaction Type: Select Stock Transfer.
Inventory Item: Select the inventory item for this stock transfer.
Location: Select the location from which to transfer the stock.
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Date: Enter the date of this transaction.
Reference: This is an optional field and is not required by the system to
save the transfer. You can use this field to enter any type of reference
number or description. A more detailed Transaction Note may be added
by clicking on the notepad icon .
Quantity Transferred: Enter the quantity to transfer. The system will not
allow you to enter a quantity of zero or to skip this prompt.
Destination Company: Select the company to transfer the stock to. If you
are transferring the stock to another location within the same company,
select the current company.
NOTE: The number of locations for the destination company
you are transferring stock to must match exactly to the
company you are transferring from. If they do not match, the
system will display an error message and not allow you to
perform the transfer.
Destination Location: Select the location to transfer to.
Accept: Click >Accept to save the transfer entered.
Cancel: Click >Cancel if the stock transfer is entered incorrectly and you
wish to start over.
The system is now ready for you to enter the next transfer or transaction
type. The system will allow you to enter an unlimited number of stock
transfers or other transaction types before you post the transactions.
When you click >Accept, the system will update the bottom section of the
screen, displaying the total transfers for all transfers entered (as well as the
totals for the other transaction types).
If you have entered other types of inventory transactions within the same
session (receipts, withdrawals, etc.) and wish to return to the stock transfer
type, simply set the Transaction Type at the top of the screen to 3 - Stock
Transfers and the system will display each line item entered during this
session.
To change a line item, select the desired line item and click >Edit. To remove
a line item, select the desired line item and click >Delete.
When all stock transfers (and other transaction types) are entered and you
are ready to update the inventory files, click >Post Transactions. The system
will post all transactions and then prompt you to print the transaction listing
report.
NOTE: The dollar amount used by the system to decrease
current period and year-to-date purchases in the source file or
location and to increase current period and year-to-date
purchases in the destination file or location is the source
item’s unit cost times the transfer quantity.
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Recording Stock Purchase Orders
This option allows you to update the inventory files to reflect inventory
quantities ordered from vendors. When you record stock purchase orders, the
system will update the on order quantity. When you receive items from the
vendors and record receipts, the system increases quantities on-hand and
decreases the quantities on order.
NOTE: If you are operating interactively with the
CertiflexDimension Purchase Order program, you will
normally record purchase orders of inventory items through
this program. DO NOT repeat the transaction through this
option. If you do, you will have duplicate entries.
To record stock purchase orders, click Inventory on the Transactions menu,
and then click Record Inventory Entries.

This screen is divided into two sections. You enter the stock purchase order
information in the top section. The bottom section displays the line item
detail for each type of transaction entered and allows you to edit or delete a
previously entered line item before you post the transaction.
Transaction Type: Select Stock Purchase Order.
Inventory Item: Select the inventory item for this stock purchase order.
Location: Select the location for which to record this purchase.
Date: Enter the date of this transaction.
Reference: This is an optional field and is not required by the system to
save the purchase order. You can use this field to enter any type of
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reference number or description. A more detailed Transaction Note may
be added by clicking on the notepad icon .
Quantity Ordered: Enter the quantity ordered. The system will not allow
you to enter a quantity of zero or to skip this prompt.
Vendor Number: Optionally, you may assign a vendor to the stock receipt
either by entering the vendor number, clicking on the spyglass icon
and selecting the vendor from your vendor listing, or entering the vendor
name or number as needed.
Accept: Click >Accept to save the purchase order entered.
Cancel: Click >Cancel if the stock purchase order is entered incorrectly
and you wish to start over.
The system is now ready for you to enter the next purchase order or
transaction type. The system will allow you to enter an unlimited number of
stock purchase orders or other transaction types before you post the
transactions.
When you click >Accept, the system will update the bottom section of the
screen, displaying the total purchase orders for all purchase orders entered
(as well as the totals for the other transaction types).
If you have entered other types of inventory transactions within the same
session (receipts, withdrawals, etc.) and wish to return to the stock purchase
order type, simply set the Transaction Type at the top of the screen to 4 Stock Purchase Orders and the system will display each line item entered
during this session.
To change a line item, select the desired line item and click >Edit. To remove
a line item, select the desired line item and click >Delete.
When all stock purchase orders (and other transaction types) are entered and
you are ready to update the inventory files, click >Post Transactions. The
system will post all transactions and then prompt you to print the transaction
listing report.
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Record Bill of Material (B.O.M.) Assemblies
This option allows you to record the production of assembled items. The
Inventory program allows production on a level-by-level basis to facilitate the
building of finished goods in stages. For example, you will normally first
produce all sub-assemblies, followed by the assemblies that use those subassemblies. Finally, you should produce the finished good.

Recording B.O.M. Assemblies
To record assemblies, click Inventory on the Transactions menu, and then
click Record B.O.M Assemblies.

Before you begin recording assemblies, you want to make sure that the
Options section is defined correctly for the assembly you want to record.
Assemble/Disassemble: Select Assemble if you want to record the
assembly of a finished good, assembly, or sub-assembly. When you
assemble an item, the system will take all the raw goods or components
and build the item.
Select Disassemble if you want to disassemble an item. When you
disassemble an item, the system will take a finished good, assembly, or
sub-assembly and break it down into its original raw material form.
Disassembly is normally done as a correction to assemblies that were
done in error.
Audit Detail: When you record assemblies, the system will produce an
audit report at the end of the assembly session. Select this check box if
you want the audit report to include a listing of all components associated
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with a finished good, assembly, or sub-assembly. If you do not select this
check box, the report will only list the finished goods produced and the
quantity of each.
Auto Sub-Assemblies: Select this check box if you want the system to
automatically produce all sub-assemblies associated with the selected
assembly. You would check this box if you normally produce subassemblies only at the time the assembly is produced.
The system can automatically produce up to 10 levels of sub-assemblies.
This means that the system can produce an assembly that is composed of
other sub-assemblies and those other sub-assemblies can be composed of
additional sub-assemblies and so on for up to 10 levels of sub-assemblies.
If you normally pull a pre-assembled sub-assembly off the shelf when you
produce this assembly, you would not select this check box.
NOTE: The system will not allow the automatic sub-assembly
option when you are using a serial master item as the finished
good or as a component.
Variable Data: Selecting this option will allow the system to ask the
quantity of any line item in Class 98 or 99. For example, if one of the
items is Labor, you will be prompted to enter the number of hours.
When the Options section is defined correctly, you are ready to record an
assembly.
Finished Good: Select the finished good, assembly, or sub-assembly you
wish to produce. When a valid item is selected, the system will display
that item’s bill of materials listing in the middle of the screen.
Reference Number: Enter a reference number for this assembly.
Quantity to Produce: Enter the quantity you wish to produce. If the
finished good is a serial master item, the system will automatically
default to a quantity of 1. If the finished good is a regular item, the
system will automatically default to the number you produced the last
time you recorded assemblies for this item.
Location: Select the location to which the quantity produced for the
assembled item should be added. If you need to produce this assembly for
multiple locations, you will need to produce the item one location at a
time.
Control Number: Select the control number to be associated with the
finished good. Optionally, you may add a detailed Production Note by
clicking on the notepad icon or view the finished good’s Production
Detail by clicking on the spyglass icon .
Production ID: Select the Production ID to be associated with the finished
good. For more information on defining Production IDs, please refer to
Categories, Locations and Sections: Maintain Sections in this guide.
Accept: Click >Accept to record the assembly.
Cancel: Click >Cancel to abort the current assembly.
Review Production: Click >Review Production to see the audit report for
this session. This will be the report that will print when you close the
B.O.M. – Record Assemblies program.
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Assembly Production
When you record the assembly, the system will produce the assembly by the
amount you entered for the quantity and update the following fields:
For the assembled item:
On-hand quantity is increased
Quantities produced are increased
Unit cost is updated
Date of last transaction is updated
History file is updated
For each of the component items defined for the assembled item:
On-hand quantity is decreased
Quantities used in the production are increased
Date of last transaction is updated
History file is updated
For the disassembled item:
On-hand quantity is decreased
Quantities produced are decreased
Date of last transaction is updated
History file is updated
For each of the component items defined for the disassembled item:
On-hand quantity is increased
Quantities used in the production are decreased
Date of last transaction is updated
History file is updated
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Inventory Reports

Inventory Reports
Printing reports in CertiflexDimension is an easy, yet powerful portion of the
program. You can define the system to print almost any report based on
almost any criteria you desire.
To print a report in Inventory, click >Reports >Inventory >Standard
Inventory Reports. The report listing will be displayed.

Click the report you wish to print. Click Options to define the reporting
criteria.
Refer to your CertiflexDimension System Manager Guide for an explanation
of each field on the Print Reports & Graphs screen and how to use the
Sort/Selects feature.
Below is a list of Inventory reports and the printing options available for each
report.

NOTE: The Review Bill of Materials and Component Shortage
reports do not use the standard report printing options. These
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two reports are explained separately at the end of this
chapter.

Sales Report
The Sales Report is an important report for the management of the inventory
items. Sales and Cost of Sales information for each item included is presented
in this report, as well as the calculated gross profit dollar amount and the
profit percentage. You should print and review this report at least once per
year. Slow moving items are easily indicated on this report. Profit margins
presented can aid in pricing decisions.

Report Criteria
Combine Locations: Select this check box if you want the report to print
the total for all locations in lieu of each individual location. If you have
only one location, the system will always print in a combined format
regardless of this selection.
Include Items with Zero YTD Sales: Select this option to include items
having zero sales for the year on the report.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.

Sales Report by Category
The Sales Report by Category prints like the standard sales report, but
automatically prints and totals by category.

Report Criteria
Combine Locations: Select this check box if you want the report to print
the total for all locations in lieu of each individual location. If you have
only one location, the system will always print in a combined format
regardless of this selection.
Include Items with Zero YTD Sales: Select this option to include items
having zero sales for the year.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.

Sales Report by Location
The Sales Report by Location prints like the standard sales report, but
automatically print and total by location.

Report Criteria
Print Location Totals Only: Select this check box if you want the report to
print the total for all locations in lieu of each individual location.
Include Items with Zero YTD Sales: Select this option to include items
which have zero sales for the year.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
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Item Location: Enter the beginning and ending item location.

Sales Report by Period
The Sales Report by Period prints a comparative period sales report.

Report Criteria
Combine Locations: Select this check box if you want the report to print
the total for all locations in lieu of each individual location. If you have
only one location, the system will always print in a combined format
regardless of this selection.
Period Type:

o
o
o

1 – 12 Periods
2 – Up to 8 Quarters
3 – 4 Years

Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.

Historical Inventory Report
The Inventory History Report prints the inventory item's archived
information. This includes the quantity, unit cost, cost of sales, and unit
purchases.

Report Criteria
As Of Date: Select the beginning date for which you’d like to print the
report.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Cost Report
The Cost Report is used to provide information on the value of the inventory
items for the current cost method. This report can also compare the cost
method used and inventory value with the value if you were using one of the
other two cost methods. This report should aid in determining the value of
the inventory, based on each of the three cost methods.

Report Criteria
Combine Locations: Check this box if you wish to combine all locations
rather than separating items by location. If you have only one location,
the system will always print in a combined format regardless of this
selection.
Include Negative Quantity Items: Select this check box if you want the
report to include negative quantities on-hand.
Include Zero Quantity Items: Select this check box if you want to include
items with zero quantities.
Report Detail Type: Select what information you want for this report.

o

Default Cost Only: The system will print for the default cost only.
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o

Avg., Latest & Std: The system will print the value of the inventory
items for the average cost method, the latest cost method, and the
standard cost method.

o

Avg., Latest, Std, FIFO & LIFO: The system will print the value of the
inventory items for the average cost method, the latest cost method,
the standard cost method, the LIFO cost method (last in, first out),
and the FIFO cost method (first in, first out).

Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.
You may also wish to sort the information even further by printing a Cost
Report by Location. This will organize the report so that each location is
printed and totaled separately.

Cost Report by Location
The Cost Report by Location report is used to provide information on the
value of the inventory items for the current cost method, per location.

Report Criteria
Print Location Totals Only: Check this box if you wish to combine all
location totals per location, rather than detailing each item’s total.
Include Zero Quantity Items: Select this check box if you want to include
items with zero quantities.
Include Negative Quantity Items: Select this check box if you want the
report to include negative quantities on-hand.
Report Detail Type: Select what information you want for this report.

o
o

Default Cost Only: The system will print for the default cost only.
Avg., Latest & Std: The system will print the value of the inventory
items for the average cost method, the latest cost method, and the
standard cost method.

Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.

Quantity Report
The Quantity Report is very useful if inventory moves quickly. The lack of upto-the-minute information on remaining inventory stock can often result in
lost sales. This report prints each included item’s stock number, description,
unit of measure, and quantity on-hand.

Report Criteria
Combine Locations: Check this box if you wish to combine all locations
rather than separating items by location. If you have only one location,
the system will always print in a combined format regardless of this
selection.
Include Zero Quantity Items: Select this check box if you want to include
items with zero quantities.
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Include Negative Quantity Items: Select this check box if you want the
report to include the negative quantities on-hand.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.

Negative/Zero Quantity Report
The Negative/Zero Quantity Report highlights inventory items with either a
negative or zero quantity on-hand. Negative quantities on-hand normally
indicates a problem with the inventory records such as data processing
errors. However, in certain cases, negative on-hand quantities are acceptable.
For example, if stock was received and shipped during the same day and the
receipt was not posted to inventory until a day or two later a negative onhand quantity could occur.
To assist in tracking potential problems relating to negative or zero
quantities for items, this report prints the last physical count quantity and
current period and year-to-date quantity totals for receipts and withdrawals.

Report Criteria
Combine Locations: Check this box if you wish to combine all locations
in lieu of separating items by location. If you have only one location, the
system will always print in a combined format regardless of this selection.
Include Zero Quantity Items: Select this check box if you want to include
items with zero quantities.
Include Negative Quantity Items: Select this check box if you want the
report to include the negative quantities on-hand.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.

On Order Report
The On Order Report allows you to review items currently on order from your
vendors. The estimated order amount is also included for cash requirements
planning.

Report Criteria
Combine Locations: Check this box if you wish to combine all locations
in lieu of separating items by location. If you have only one location, the
system will always print in a combined format regardless of this selection.
Include Inactives: Select this check box if you want the report to include
the inactive inventory items.
Include Zero Qty. Items On Order: Select this check box if you want to
include items with zero quantities on order.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.
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Suggested Order Report
The Suggested Order Report assists in keeping inventory at stock levels
necessary for the best management of the business. Having insufficient stock
on-hand when a customer order is received could translate into a lost sale. On
the other hand, keeping a large stock of potentially slow moving items could
mean you have money tied up in inventory unnecessarily.
This report provides you with timely information regarding current stock
level conditions, including a calculated suggested order for each item. The
system calculates the suggested order based on information you are allowed
to specify for each item. The vendor number defined for each item is printed
and a column is provided for personnel to note the quantity ordered.
The system calculates the suggested order for each item included, by the
following:
The system adds the on-hand quantity with the quantity on order, and then
subtracts the quantity on backorder to determine how close you are to the
minimum stock level desired. The result is then compared to the minimum
quantity needed. If the result is greater than the minimum quantity needed,
the process is finished and no suggested order will be made because you are
not below the minimum quantity needed. If the result is less than the
minimum quantity needed, one final step is processed. If the result is equal to
or greater than the minimum quantity to order defined for the item, the
suggested order is the quantity needed to bring the item to the minimum
quantity. If the amount is less than the minimum quantity to order, the
suggested order is the minimum quantity to order.
An example will help illustrate the suggested order calculation.
The quantity fields for the example are as follows:
Quantity on-hand
Quantity on order
Quantity on backorder
Minimum quantity needed
Minimum quantity to order

10.00
5.00
6.00
50.00
20.00

The suggested order for this item based on this data is 41.00, calculated as:
(10.00+ 5.00) - 6.00 = 9.00
50.00 - 9.00 = 41.00

Report Criteria
Combine Locations: Check this box if you wish to combine all locations
in lieu of separating items by location. If you have only one location, the
system will always print in a combined format regardless of this selection.
Include Inactives: Select this check box if you want the report to include
the inactive inventory items.
Include Zero Qty. Sugg. Items: Select this check box if you want to
include items with zero quantities suggested.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.
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Detailed History Report
The Detailed History Report prints the inventory item’s history to date
detailed transactions. This includes the transaction date, the transaction type
and number, the location (if applicable), the quantity, unit cost, unit price,
the customer or vendor for which the transaction was made, the salesperson
(if applicable), and the user posting the transaction.

Report Criteria
Print Unit Cost: Select this check box if you want the report to include
each transaction’s unit cost.
Print Unit Price: Select this check box if you want the report to include
each transaction’s unit price.
Print Totals Only: Select this check box if you want to show totals only.
Print Index Page: Select this check box to include an index page at the
end of the report that lists each item and its corresponding report page
number.
Reporting Period: Select the period for which to report. If you select Date
Range, the system will prompt you for the beginning and ending dates.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Summarized History Report
The Summarized History Report prints the inventory item’s current and
year-to-date unit purchases, dollar purchases, unit sales, dollar sales, and
cost of goods sold.

Report Criteria
Combine Locations: Check this box if you wish to combine all locations
in lieu of separating items by location. If you have only one location, the
system will always print in a combined format regardless of this selection.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.

Inventory Item Use Report
The Inventory Item Use Report sorts up to 2,500 items by the last transaction
date in ascending order. The report includes each inventory item’s stock
number, description, last transaction date, on-hand quantities, and current
extended costs. The report can help determine the inventory items that are,
or are not, being purchased.

Report Criteria
Include Items Not Used: Select this check box if you want the system to
include any inventory items not purchased during the reporting period.
Print Zero Quantity: Select this check box if you want to include items
with zero quantities.
Reporting Period: Select the period for which to report. If you select Date
Range, the system will prompt you for the beginning and ending dates.
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Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Price List
Price List allows you to print inventory price lists in a variety of formats to
suit the needs of the company. You can specify whether to include any
combination of price dollar amounts, markup percentages and price break
quantities.

Report Criteria
Include Inactive Items: Select this check box if you want to include
inactive inventory items.
Print Unit Cost: Select this check box if you want unit cost information to
be included.
Print Gross Profit: Select this check box if you want gross profit
information to be included.
Print Markup Percentages: Select this check box if you want markup
percentage information to be included.
Print Break Quantities: Select this check box if you want price break
quantities information to be included.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Product Catalog
This report will print a catalog of inventory items and any pictures or images
specified for the item.

Report Criteria
Include Inactive Items: Select this check box if you wish to include
inactive inventory items.
Include Item Image: Select this check box if you wish to include item
images.
Price Level: Select the price level you wish to use.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Item Labels
Item Labels allows you to print stock labels for the inventory items. Printing
criteria is very flexible to allow you to generate exactly the group of labels you
need.

Report Criteria
Include Inactive Items: Select this check box if you wish to include
inactive inventory items.
Print in Bin Number Order: Select this check box if you want the labels to
print in bin number order. If you want the labels to print in inventory
item index order, do not select this check box.
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Print Label Titles: Select this check box if you want the titles of the fields
included on the label printing to print in addition to the contents of the
fields.
Item Bar Code: Select this box if you want the item labels to include a
bar code.
Print Selected Locations: Select this box if you want locations to print on
the labels.
Item Bar Code: The following specifications can be set for printing item
bar code information:

o

None: Select this box if you do not need bar codes printed on the
labels.

o

Bar Code Vendor Item No.: Select this check box if you are printing
bar codes. The system will use the Vendor Item Number to determine
the bar code for each item.

o

Bar Code Item Stock Number: Select this check box if you want the
printed Bar Code to be the Item Number.

o

Bar Code Primary Lookup Key: Select this check box if you want the
printed Bar Code to be the Primary Lookup Key for this item.

If you select either Bar Code Vendor Item No. , Bar Code Item Stock
Number or Bar Code Primary Lookup Key, the following options may be
set:



Print Readable Text: Check this box if you wish to print the bar
code number at the bottom of the bar code.





Bar Code Type: Select the type of bar code you wish to print.
Width: Designate the width of the bar code in inches.
Height: Designate the height of the bar code in inches.

Avery Label Brand: Select the type of label.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.
Label Fields to Print: The system will display all fields available for
printing on the label. Click on the fields you wish to include on the label.
The system will place a check mark next to each field selected.

Count Sheets
Count Sheets allow you to print numbered count sheets on which you can
record physical counts during a physical inventory. Count Sheet printing is
very flexible to include any range of inventory items, classes, locations, and
can also print in bin number order. For each inventory item included on the
report the item’s stock number, description, unit of measure, bin location, and
three places to record the physical counts will be printed.
Remember, it is very important that counts taken and recorded match each
item’s unit of measure as defined on the item’s record. Do not record physical
counts in an alternate unit of measure.
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Report Criteria
Include Inactive Items: Select this check box to include inactive
inventory items.
Print in Bin Number Order: Select this check box if you want the report to
print in bin number order. If you do not select this check box, the system
will print in inventory item index order.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.

Book-to-Physical Report
The Book-to-Physical report is very helpful because it highlights the
differences in the inventory files and the physical counts you entered through
Update Physical Counts. The extended value of each difference is also
presented on this report as an aid in the reconciliation process.
The Book-to-Physical report is an important tool in reconciling the on-hand
quantities with the results of a physical count. You should print this report
after entering the physical counts to determine which items show a difference
between the on-hand quantity and the physical quantity. You should
investigate all differences you consider significant.
If the difference and extended difference is a negative amount, then you have
more items on-hand than you actually counted. This represents a shortage.
If the difference and extended difference is a positive amount, you have fewer
items on-hand than you actually counted. This represents an overage.
For items with significant differences, you should normally recount the items.
Many counting errors are due to unit of measure problems. Be sure to count
each item in its original, purchased unit of measure.
If you recount and determine the count to be correct, then one of three things
could have happened: (1) the original quantities were defined incorrectly, (2)
errors were made in entering inventory transactions (receipts, withdrawals,
etc.), or (3) there was mishandling of the actual stock (theft or misplacement).
You should print the Book-to-Physical report after you input the initial
counts and after entering each group of recounts. When all quantities
possible are reconciled, you should print a final copy to retain for your
records. This report will print the dollar total of all differences not reconciled.
This dollar amount should normally be booked in the General Ledger with a
journal entry so that inventory amounts in the General Ledger and the
Inventory module remain in agreement.
NOTE: The Book-to-Physical report prints only for inventory items
that have a difference between the on-hand quantities and the
physical counts entered.

Report Criteria
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
Item Location: Enter the beginning and ending item location.
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Item Listing
The Item Listing report prints a list of all inventory items for the company.

Report Criteria
Include Inactive Items: Select this box to include inactive inventory
items.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Item Maintenance Report
The Item Maintenance Report prints each item’s complete record information
as seen in Adding an Inventory Item.

Report Criteria
Include Inactive Items: Select this box to include inactive inventory
items.
Include Alternate Information: Select this check box if you want the
report to include alternate inventory item information for each selected
inventory item.
Include Additional Memos: Select this check box if you want the system
to include the additional memo line information for each included
inventory item.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Serial/Lot Number Report
The Serial/Lot Number Report prints a list of all Serial/Lot numbered
inventory items.

Report Criteria
Include Inactive Items: Select this box to include inactive inventory
items.
Include Closed Serial/Lot Numbers: Select this box to include all closed
Serial/Lot numbered items.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Serial/Lot Quantity Report
The Serial/Lot Quantity Report prints a list of Serial/Lot inventory item
quantities.

Report Criteria
Include Inactive Items: Select this box to include inactive inventory
items.
Detailed: Select this box to produce a detailed report that prints each
serial/lot numbered item’s location.
Item Class: Enter the beginning and ending item class.
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Item Category: Enter the beginning and ending item category.

Kit Listing
This report will print a list of all inventory kits with the location and quantity
of each kit.

Where Used Report
This report will print for component items and lists where the components
are used.

Report Criteria
Include Inactive Items: Select this checkbox if you wish to include
inactive inventory items.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Finished Good Production Report
The Finished Good Production Report prints assembled items and lists the
stock number, description, current period quantity produced, and year-todate quantity produced for each assembled item.
The system will print finished goods that have a current period quantity
produced or a year-to-date quantity produced only.

Report Criteria
Include Inactive Items: Select this checkbox if you wish to include
inactive inventory items.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.

Component Production Report
The Component Production Report prints for component items and lists the
stock number, description, current period component quantity used, and
year-to-date component quantity used for each component item.
The system will only print for components that have either a current period
quantity used in production or a year-to-date quantity used in production.

Report Criteria
Include Inactive Items: Select this checkbox if you wish to include
inactive inventory items.
Item Class: Enter the beginning and ending item class.
Item Category: Enter the beginning and ending item category.
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Additional Reports
Reviewing/Printing Bill of Materials
This review and accompanying report displays each component’s unit and
extended cost and the assembly’s gross profit percentage.
To review the bill of materials, click >Reports >Inventory >Print Bill of
Materials.

Finished Good: Select the finished good, assembly, or sub-assembly you
wish to review. When a valid item is selected, the system will display that
item’s bill of materials listing and history detail on the right side of the
screen.
Print B.O.M.: Click Print B.O.M. to print the Bill of Materials Cost Detail
Report.

o

Range: Select the range of items for which you want to print the
report.

o

Cost Method: Select the cost method you wish to use for the
calculation. You may select Average Cost, Latest Cost, or Standard
Cost.

o

Type: Define the following:



Price Level: Select the price level you want the system to use
when calculating the gross profit percentage.



Auto Sub-Assemblies: Select this check box if you want the
system to display all sub-assemblies associated with the selected
assembly.
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Show Prices: Select this check box if you want the B.O.M. report
to display prices.



Additional Description: Select this check box if you want the
B.O.M. report to include any additional descriptions that have
been added.

Component Shortage Analysis/Report
The Component Shortage Report allows you to select one or more assemblies,
enter the quantity needed to produce, and obtain a shortage report for each
component.
For example, suppose you need to know if you have enough materials onhand to produce 3 assemblies #1, 15 assemblies #2, and 9 assemblies #3. To
determine if you had enough materials on-hand for these assemblies, you
would use this option and enter assembly #1 in the Finished Good prompt,
enter a quantity of 3, and click >Accept. You would repeat these steps for the
other two assemblies. When you click >Print Shortage Report, the system will
calculate all materials needed for all assemblies entered, compare those totals
with the amount of inventory currently on-hand, and print a shortage report
for those items that you do not have enough of to produce the selected
assemblies.
To print the component shortage report, click >Reports >Inventory
>Component Shortage Analysis/Report.

Finished Good: Select the finished good, assembly, or sub-assembly you
wish to review. When a valid item is selected, the system will display that
item’s bill of materials listing in the lower half of the screen.
Quantity to Produce: Enter the number of assemblies to use for the
creation of the shortage report.
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Options: Auto Sub-Assemblies: Select this check box if you want the
system to include all sub-assemblies associated with the selected
assembly.
Clear Production List: Click this button to clear the production list and
generate another shortage report for the selected assembly or to generate
a shortage report for another assembly.
Review Production List: Click this button to review the production list
entered. You would use this button if the items you entered above were
more than would fit in the viewing area of the screen.
Print Shortage Report: Click this button to print the shortage report.
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Inventory WorkSheet Reports
Using WorkSheet Reports in CertiflexDimension is an easy, yet powerful
portion of the program. You can use this system to create almost any
interactive WorkSheet you desire.
To use an Inventory WorkSheet Report, click >Reports >Inventory
>WorkSheet Reports.
The system will display a WorkSheet Listing for your selected module. Select
the WorkSheet you wish to use and click > Create.

NOTE: Each WorkSheet can be saved in three different
styles. The system will always start with the “Default” style
saved for this WorkSheet.
The options for formatting and printing WorkSheets are the same in all
systems. For detailed information about each of these specific functions,
please refer to your CertiflexDimension System Manager Guide – WorkSheet
Reports.

WorkSheets
Below is a list of WorkSheet Reports available for this module.
Item Listing
Item Activity
Comparative Year Sales
YTD Quantity Analysis
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Suggested Order Report Compressing Data Files

Compress Detailed Inventory Item History
Compressing the inventory history file allows you to have the system remove
old history information from the system’s data files. You would periodically
select this option to remove old transaction information that you no longer
need or want in the data files.
We recommend that you perform this option as part of the year-end
processing procedures. For example, if the company needs to have the last
two years of transaction information on file, at the beginning of each year,
you would compress the unneeded year.
To compress the inventory item history file, go to >File >Data File
Maintenance >Compress Data Files. Click >Next to proceed to the File List.

File List: Select the data file to compress. For the inventory item history
file, select IN2 - Detailed Inventory Item History. Click >Next.
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Compression Type: This selection allows you to define how many years
of history transactions to remove from the files.
NOTE: Many CertiflexDimension reports generate their
information from the history files. Be careful of the selection
here. If you compress history transactions and then later
attempt to print a report that generates its information from
the history files for a date that has been compressed, the
system will not be able to retrieve the information without
you restoring a backup.
Click >Next. The system will display a screen detailing the information
selected to compress. To begin the compression, click >Compress.
NOTE: Make sure that you have at least two good backups of
the data files before you begin the compression. Once the
compression option begins, you must allow the system to
complete the process. If you experience a power failure or if
something interrupts the compression process, the system will
require you to restore a backup.
If you are operating on a network, make sure that all users
have logged off of CertiflexDimension. The compression
program will not operate properly if there are users, except
for yourself, logged on to the CertiflexDimension program.
The amount of time the compression program takes depends upon the
number of transactions currently in the history file and the speed of your
machine. We recommend that you do not perform this option during the busy
part of your day because once you start the compression, you cannot stop the
process without having to restore a backup.
Once the compression program is complete, the system will have deleted all
history transactions through the selected date. The system will not be able to
access any transactions prior to the Compression Type date without
restoring a backup.
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